Operatlon Model CX1000/CX1006/CX1200/CX1206

Guide DAQSTATION CX1000

vigilant

*4 L 31 A1 04 EO0 4

YOKOGAWA ¢ IM 04L31A01-04E

4th Edition
Yokogawa Electric Corporation




Contents

INtroduction 10 CONIOl FUNCHIONS .......oiiiiiiiiie ittt e et b b e et e sb et e b e e nbe e et e e nnneeaneas 4
(070011 (o] [ 1Y/ o= S TSP PRSP URR PR 4
[ 1 0]\ (o] I 1¥ o e} i o] o HU PP PO P RSP PPUPPPPPRR 4
Control SUPPreSSION FUNCHON .......ooiiiiiiii ettt b e e e bt e st et e sbe e e e sab e e e ebeeeenees 5
JLILEE (e (L Vo T Vg T (o o PP 6
CONtrol AIGIMN FUNCHON ...ttt b et b e et sb e e et e e s b bt ebe e ean e e sbe e e neesneeebeennneebeas 6
L ATL L4V TSP OUPPOPPPTTRRT 7
L)YV N o @] o1 = L1 [o] o T OSSP P PP PP PPPR 8
NGV O] o =T =1 (1o H T TSP PP U P UPROURURRPRN 8
SWiItChiNG OPEration MOTES ........iitiiiiiitie ittt b ettt b et esae e e bt e as e e ee e e bt e sareeneesareeneenane s 8
Switching Displays during Operation MOGE ..........cuuii ittt s e e e e nre e e nnes 8
CoNtrol OPEration DISPIAY .......coiiuiiiiiiie ittt e st e e s bt e e ek et e s aaee e e sb et e e bt e e anbeeesne e e e anbeeeenreeennes 9
List Of CONTrOl SEIUP IEIMS ...ttt b et nb e ss bt b e san e e nbeeenneebeas 10
Examples of Control SETUP OPEIAtiON .........cccuiiiuieiiiiiieiii ettt sb e b e s e e e be et e e saneeneesareenneenareen 11
Control Setup Example 1: Single LOOP CONIOL .......ooiueiiiiiiie ittt 11
Control Setup Example 2: CasCade CONTIOL........c..uiiiieiiiiiie et e b e e 15
Control Setup Example 3: Loop Control with PV SWItChING ..........cooiiiiiiiiiiiieee e 20
Control Setup Example 4: ON/OFF CONIIOL .......oiiuiiiiiiiieeieeee ettt ne e 23
Setting the Display ltems on the Control Group Display (Control Group Setting) .......ccccoovveeeiiiiiiiie e 26
Displaying the Trend of PV, SP, @nd OUT VAIUES ........ccoouiiiiiiiiiiiiie ettt s 27
SWitching the OPEration MOE .........couiiiiiiiii ittt b e b e bt s bt e bt e bt e sh bt e be e san e e nbeesnneenneas 29
{0 TS (o] @] o 1=T =i To] ISP P P OPP PR PPPRPROPR 29
Switching between Auto, Manual, and Cascade CONTrOl...........oiiuiiiiiiiiiiiie e 29
Changing the Target SEPOINT ..........cooiiii e e e e e 30
Changing the CONTrOl OUIPUL ........ouiiieiie ettt b e b e b sh e e st e e ae e sab e sneenane e e 30
Switching between Remote and LOCAl MOAES .........cccoiiiiiiiiiiiiiieiee e 31
Switching between Automatic and Manual for the Analog RetransmisSion LOOP .......cccuvviiiereiiiiieiiiee e 31
Changing the Analog Retransmission OUIPUL ..........ccoiiiiiiiiie e e 32
Switching between Automatic and Manual for the DIO Operation MONItOrNgG .........ccovieieeiireenieiieeree e 32
Changing the DO Output for the DIO Operation MONIOFNG ..........coieeiiiaiienie e 32
VLTI o @] oT=T o= (o] o ISR TP 33
Displaying the TUNING DISPIAY ......ccouuieiiiiieiiiii ettt s b e st e ebe e e s nr e e e aabeeeenreesnnes 33
U1 o T 1001 o PSPPSR PR 33
= o TUE= LI 0 1 o PSSP 34
Program Control Function (/PG1 and /PG2 OPHIONS) ......eeiiiueeiiiiiieeeiiee ettt ettt e e e s e s snneeesneee s 35
Program Control FUNCHON INTTOAUCTHION .........ccoiiiiiiiiiie e 35
Operation Mode during Program CONTIOL ..........cciuiiiuieiiieiie ettt b et sbeesae e eseeenane e e 35
Operations on the Program Selection DiSPIAY ..........coiuieiiiriiieiiieiie ittt 35
Operations on the Program Control DISPIAY ...........eeeiueeiiiiieiieee ettt se e s b s nee e e sanes 36
Program Control SEUP OPEIatiON ...........iiiiiiiiiiie ittt e e st e st e e e sas e e e bs e e e anbe e e saneeesaneee s 38
[y B B =T =T 1= (T PP P RO PRR 44

2 IM 04L31A01-04E



Note

Trademarks

Revisions

4th Edition: May 2007 (YK)

Thank you for purchasing the CX1000. This operation guide briefly explains the main
operations related to the loop control function of the CX1000. For information about all
the functions excluding the communication functions, installation and wiring procedures,
operating procedures, and handling precautions of the CX1000, see the electronic
manual CX1000 User’s Manual (IM 04L31A01-03E) provided on the accompanying CD-
ROM. The following five manuals are provided in addition to this manual and the CX1000
User’s Manual. Read them along with this manual.

Electronic Manuals Provided on the Accompanying CD-ROM

Manual Title Manual No. Description

CX1000/CX2000 IM 04L31A01-17E  Describes the communication functions of the
Communication Interface CX1000 using the Ethernet/serial interface.
User’s Manual

DAQSTANDARD for IM 04L31A01-61E  Describes the functions and operating procedure
CX User’s Manual of the software “DAQSTANDARD for CX” that

comes with the package.

Paper Manuals

Manual Title Manual No. Description

CX1000 Installation and IM 04L31A01-73E  Describes concisely the installation procedures
Connection Guide and wiring procedures of the CX1000.
Precautions on the Use IM 04L31A01-72E  Precautions regarding the use of the CX1000/
of the CX1000/CX2000 CX2000.

Control of Pollution Caused IM 04L31A01-91C  Gives a description of pollution control.
by the CX1000/CX2000

+ This manual provides information on the CX1000, style number “S3.”

+ The contents of this manual are subject to change without prior notice as a result of
continuing improvements to the instrument’s performance and functions.

« Every effort has been made in the preparation of this manual to ensure the accuracy
of its contents. However, should you have any questions or find any errors, please
contact your nearest YOKOGAWA dealer.

« Copying or reproducing all or any part of the contents of this manual without
Yokogawa’s permission is strictly prohibited.

+ The TCP/IP software of this product and the document concerning the TCP/IP software
have been developed/created by YOKOGAWA based on the BSD Networking Software,
Release 1 that has been licensed from the Regents of the University of California.

+ vigilantplant, DAQSTATION, and Dagstation are registered trademarks of Yokogawa
Electric Corporation.

+ Microsoft and Windows are registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

+ Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems
Incorporated.

+  Company and product names that appear in this manual are registered trademarks or
trademarks of their respective holders.

« The company and product names used in this manual are not accompanied by the
registered trademark or trademark symbols (® and TM).

1st Edition  April, 2002 4th Edition  May, 2007
2nd Edition  January, 2003
3rd Edition  June, 2003

All Rights Reserved, Copyright © 2002 Yokogawa Electric Corporation
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Introduction to Control Functions

For further details on each function, see chapter 1, “Explanation of Functions” in the

CX1000 User’s Manual (IM 04L31A01-03E) provided on the accompanying CD-ROM.
Control Types

Control Mode

The following four modes are available (three types of control plus analog

retransmission).

Single-loop control Cascade control  Loop control with PV switching Analog retransmission

PV PV1 PV2 PV1 PV2
Output comes from
the control output

sp—_PD_| SP J SP—{ PID_| channels per the

results of the

ouT | PID | ouT specified equation.

l PV: Process value
ouT SP: Target setpoint

OUT: Control output
Control Operation Mode

You can specify one of the following operation modes. However, program control
operation can be specified only on models with the program control option.

+ Fixed-point control (program control OFF): Set the SP locally or use remote input
+ Program control operation: Set the SP locally or use program patterns

PID Control Function
Control Computation Types and Control Output Format
You can select from time proportional PID control (voltage pulse/relay output),
continuous PID control (current output), or On/Off control (relay output).
Control Direction
You can select the direction in which OUT changes according to the polarity of the
deviation between the SP and the PV.
+ Reverse action (PV > SP: OUT decreases, PV < SP: control output increases)
« Direct action (PV > SP: OUT increases, PV < SP: control output decreases)
PID Control Mode
You can select the change in the operation when the SP is changed.
+ Follow-up: Controlled so that the output reaches the new SP quickly
+ Fixed-point: Suppresses sensitive reaction of the output to change to the new SP
PID Control Method
One of the following methods is automatically selected depending on the PID control
mode and the control operation mode.

+ PV derivative type: Control method in which the control output is kept from
changing radically when the SP is changed by a great
amount

+ Deviation derivative type: Control method in which fast response to follow the SP is
emphasized

Control Parameter (“PID Parameter” in the Settings)

You can set up to eight groups of control parameter sets for each loop. Control
parameters include SP, PID constant, control output limiter, manual reset value, control
direction, and preset output.
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Introduction to Control Functions

PID Parameter Selection Method

You can select the method for switching PID parameters from the following:

+ Target setpoint selection: By specifying the SP number.

« Zone PID selection: By dividing the measurement span in to multiple zones and
determining in which zone the PV resides.

+ Segment PID selection:  Using the program pattern segment when in program
control.

Tuning

There are two methods: auto tuning of PID constants using the limit cycle method, and

manual tuning that allows PID parameters to be set individually during operation.

Control Suppression Function

Anti-Reset Windup (Over-Integration Prevention)

Overshoot may occur if the deviation between the SP and PV continues for an extended
time and the control output reaches the output high-limit through the integration process.
To prevent this from happening, the anti-reset windup function is used to pause the
integration process when the manipulated output reaches the high limit of the output
limiter.

N Stop PID Start PID
100% computation computation

Output |----—- N
high limit Output
value

- Time

- Time

Overshoot Suppression Function (“Control Output Suppression” in the Settings)
The deviation is monitored to detect the danger of overshooting and automatically
changes the SP to a slightly lower tentative value referred to as the “auxiliary target
setpoint” and continues control. Then, when the process value enters a range in which
overshooting is no longer a danger, the auxiliary target setpoint is gradually returned to
the original SP.

PV Auxiliary SP

Original SP N / ’

Time

Control output Start fuzzy logic
suppression function On

Control Output Limiter

You can set high and low limits of the control output range ("output high-limit/low-limit” in
the settings) regardless of the operation mode.

Shutdown

This function is used to close the control value fully (set the output to 0) exceeding the
dead band of the control valve positioner.

Output Velocity Limiter

This function is used to prevent radical changes in the control output to protect the
control element and object of control.

IM 04L31A01-04E



Introduction to Control Functions

Preset Output

This function sets the control output to the preset value when the operation is stopped.
SP Ramp-Down-Rate/SP Ramp-Up-Rate

This function is used to decrease or increase the setpoint at a constant rate of change
(as opposed to a rapid change) when the SP is changed.

Target Setpoint Limit

This function is used to limit the range of values that the SP can change.

Tracking Function

You can set the following two tracking functions to suppress a radical change in the

output.

SP tracking: When switching from remote to local operation mode, the output is tracked
to the remote SP immediately before the SP switching.

PV tracking: The SP is matched to the PV at that point and then returned to the original
value according to the target setpoint ramp-up rate or the target setpoint
ramp-down rate.

Control Alarm Function
You can set up to four alarms for each loop. The following alarm types can be specified.
PV upper-limit alarm, PV lower-limit alarm, deviation high limit alarm, deviation low limit
alarm, deviation high/low limit alarm, deviation high and low limits alarm, SP high limit
alarm, SP low limit alarm, output high limit alarm, and output low limit alarm.
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Input/Output terminals are arranged on the rear panel of the CX1000 as shown in the
figure below. The figure shows the case when option terminals are specified on the
model with 2 internal control loops and 6 measurement channels (CX1620). For the
wiring procedure of the control/measurement input/output, see chapter 2, “Installation
and Wiring” in the CX1000 User’s Manual (IM 04L31A01-03E) or the CX1000 Installation
and Connection Guide (IM 04L31A01-73E). For a description on the connection of
communication interfaces such as the serial or Ethernet interface, see the CX1000/
CX2000 Communication Interface User’s Manual (IM 04L31A01-17E).

Serial communication

PC
|

+ Universal control output: for 2 loops | lo —

Select current, voltage pulse, or Controllers (up to 4 loops)

relay output. 100 VAC to 240 VAC. PLC
- Control contact input: 6 inputs LAN 2: V(?C/AC (/P1 option) Lsyugglgggfv\z‘\\)-l\ﬂ
- Control contact input (Ethernet) CX1000

Relay output: 2 outputs

Transistor output: 4 outputs |

(©)
@ @ @ @ @ @ ||[ LNl @ Select one from the following option terminal blocks.

Measurement alarm output Measurement alarm
(/A6 option) output + remote input/

output (/A6R option)

© o |

=1
il Measurement alarm

Measurement alarm output +
Magnet SSR Contact Contact ) FAIL/memory end output °”t§‘g M FﬁlL/men;(ter
; i /A4F option) . _encoutput + remote
switch input  output ( input/output (/A4FR option)
6 inputs 6 outputs O‘ RS

5 universal measurement inputs (control) 6 universal measurement inputs (measurement)

Control/measurement |nput
terminal block

{10
@]
(]
@]
%
@
@]
@
@
@

Control Terminal Arrangement of the Control/Measurement Input Terminal Block
(Conceptual Diagram)

The following figure denotes the three terminals (/b, +/A, -/B) of a single column of
control input terminals using a single cell.

Control inplut terminals Measurement input terminals
!
[Control mode setting] LOOPZ_ 3 1L020P11 5 é
During single-loop control = (Rsp) [ PV O [(sp) | PV
During cascade control —| O [ pPv | O [(RSP) | PV _|
During loop control with —[ pv2 [ Pvi [ (RSP) [ Pv2 | PV1 |
PV switching PV, PV1, PV2: PV input, (RSP): RSP input

(not used during program control), (I: unused terminal

Terminal Arrangement of the Control Output Terminal Block

Control current
Control relay  Relay contact voltage pulse Transistor Contact

contact output output output output input
[ ] [ 1 [ 1 [ 1
DIGITAL OUT DIGITAL OUT DIGITAL IN
O O LOOP2 | LOOP1 2 1
[(NO]|[NO] (51 [3]||C4a] 1]
0o O |[NC]|[NC] (6] [4][5][2]
S 0| O ] 6] (3]
CTRL OUT
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Overview of Operations

Key Operation
For details on the key operation, see chapter 3, “Names of Parts, Display Modes, and
Common Operations” in the CX7000 User’s Manual (IM 04L31A01-03E).

Select the value or execute the operation
that is displayed in soft key menu

Confirm the value
or operation

Select parameters or move the cursor

Start/Stop data Execute the Switch between operation mode and setting mode
acquisition to assigned ;

the internal action Cancel an operation

memory and Switch from setting mode to

waveform display basic setting mode or display

possible functions in operation
mode in the soft key menu
Switching Operation Modes
There are four operation modes: operation mode, control setting mode, common and
measurement setting mode, and basic setting mode.

Power ON Display Transition Diagram
Operation mode

[End] soft key -> DISP/ENTER key
(This operation saves the settings made

) ) in the basic setting mode.)
Operation display

MENU key or ESC key

MENU key ESC key
Control setting mode Common and measurement setting mode Basic setting
[Setting mode (Control)] [Set mode] mode
M T
MENU key Press the FUNC
Menu Press the FUNC Menu keyfor3 s Menu
key for 3 s
Soft keys l MENU key or Soft keys l MENU key or Soft keys l ESC key
ESC key ESC key
Setup display Setup display Setup display
(#1 to #8") (#1 to #11) (#1 to #12™)
* #1 to #9 when program control " #1 to #11: Basic common and
is ON. measurement settings

#12: Basic control settings
Switching Displays during Operation Mode
You can change the operation display according to your needs by carrying out the
following procedures.

. =
Operation v _—— :

display .

Sub menu

} 1 .
Display selection menu

indicates the DISP/ENTER key. 4 ¥ » indicate the arrow keys.

IM 04L31A01-04E



Overview of Operations

Control Operation Display

In operation mode, the following control operation displays can be selected.
+ Control group display
This display is used to monitor the control status of multiple loops simultaneously
including external loops. You can select from three display styles as shown in the
display example in the figure below. If you include the measurement channels for the
measurement function in the group, you can also monitor the measured values on
the measurement channels at the same time on this display.
+ Tuning display
This display is used to optimize (tune) the control parameters such as PID constants.
+  Overview display
This display is used to monitor the alarm status of all control loops.
+ DI/DO status display
Displays the ON/OFF status of the current contact input (DI) and contact output (DO).
+ Control action summary display
Displays a log of control actions such as operation run/stop and auto/manual
operation switching.
+ Internal switch status display
Displays the ON/OFF status of the internal switch.
On models with the program control function option, the following additional displays are
available: 1) the program operation status display, which can show the pattern and
current PV accumulated on the screen during program operation and 2) the program
event summary display, which shows a log of time events and PV events that occurred
during program operation.
Displays common with the measurement function include: 1) the alarm summary display,
which shows a log of alarm occurrence status and 2) the memory summary display,
which shows the file information of the internal memory.
In addition, on the trend display of the control function, the PV, SP, OUT can be assigned to
virtual channels (control channels), and the trend of control status can be displayed like the trend
waveforms of measurement channels on the trend display of the measurement function.

Controller style Faceplate style Hybrid style
+ Tuning displa + Overview display - DI/DO status display
L7 B0 IEE(S) Edo

+ Internal switch status display
m v R ()

2 fzzem ||
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Overview of Operations

List of Control Setup Items

Basic Control Setup Items in Basic Setting Mode
#1 Control action
PID number, control period, zone PID, restart mode, initial PID, auto tuning, control
mode, method (only during loop control with PV switching), program control ON/OFF
(only on models with the program control option), and PID control mode.
#2 Input setting
Burnout and RJC.
#3 DI/DO/SW-registration
Contact input registration
#4 AUX
Remote setting, alarm mode, SP number selection source, PV/SP math, CLOG error,
and event output setting.
#5 Output processing
Control output, cycle time, and analog-output type
#6 Relay
FAIL ON/OFF, self diagnosis ON/OFF, and relay action/behavior (energize/de-
energize, hold/nonhold)
#7 Tuning setting
Tuning item selection
#8 External loop setting (For details on the settings, see the CX71000/CX2000
Communication Interface User's Manual (IM 04L31A01-17E).)
Setup Items in the Control Setting Mode
#1 Control input range
Input type, mode, type, range, span, scale, unit, square root, low-cut, bias, filter, and ratio.
#2 Control alarm
Type, standby, relay output ON/OFF, and alarm value
#3 Operation-related parameters/Zone PID
Suppressing function, ramp-rate-time unit, SP ramp-down-rate/SP ramp-up-rate, tag,
tag comment, reference point (when zone PID is selected), switching hysteresis
(when zone PID is selected), and reference deviation (when zone PID is selected).
#4 PID parameters
SP, PID constant, output limit, shutdown ON/OFF, manual reset, relay hysteresis
(only during ON/OFF control), reverse/direct, and preset output.
#5 Control group setting
Group name, kind (internal loop/external loop/measurement channel), and number.
#6 Ten-segment linearizer 1/0
Input type, mode, and biasing or approximation input/output values.
#7 Program control (only when program control is ON)
#1 Program parameter setting
Pattern initial setting, wait action setting, program start setting, program pattern
setting, event setting, hysteresis (PV event), and repeat action setting.
#2 Event output setting
#3 AUX (Auto message, Display position)
#4 AUX (event display group)
#8 Detailed setting (When program control is OFF, Detail setting is #7)
#1 Control function
SP tracking, PV tracking, SP limiter, output velocity limiter, and anti-reset windup
auto/manual.
#2 Hysteresis (Alarm)
#3 DIO monitor and operation setting
#4 DI/DO label setting
#9 Control math setting (When program control is OFF, Control math setting is #8)
#1 PV/SP math, Retransmission
#2 Logic math (#1 when both PV/SP computation and analog retransmission are inactive.)
#3 Constant (#2 when both PV/SP computation and analog retransmission are inactive.)
Constant used in computations for control

10
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Examples of Control Setup Operation

Control Setup Example 1: Single Loop Control
Object of Control and Description

CX1000 Alarm output
DIGITAL OUT13

—V“ High limit temperature alarm

DIGITAL OUT2?3

PV

TC | LOOP1 PV!

Electric _>. Low limit temperature alarm
furnace
TLoop 1 PV input terminal
LOOP1 PULS? of the control input terminal block
‘ 2 Loop 1 voltage pulse output terminal
SSR Xg:;%?g"’t'set of the control output terminal block
| UIPU 3 Relay contact output terminal
of the control output terminal block
)
7
+ Loop number: 1
+ PID constant: P=5%,1=240s,D=60s
+ Control direction: Reverse
+ Input type: TC K type
+ Measurement span: 0 to 1200°C
+ Output type: Voltage pulse (cycle time: 3 s)
+ Temperature setpoint: 700°C
+ Alarm output: PV high-limit alarm (high limit: 800°C), PV low-limit alarm (low

limit: 600°C)

Basic Control Settings

1. From the operation display, open the basic control setting menu according to the
following procedure.
Press the MENU key (to switch to Set mode), then hold down the FUNC key for 3 s
(to switch to basic setting mode). Press the Next 1/4 soft key, followed by the Next
3/4 soft key, and then the #12 soft key (to select Control).

Menu (Setting mode (Control)) Menu (Basic setting mode 1/4)
: Setup Mode
Setting mode{Control} Basic setting mode
#1 Cantral input range #1 Alarm
n Control alarm m A4D, Temperature
Operation-related parameters/Zone PID - Hemary
FID parameters Hemory and trend,Hemory timeup
| #1142 [ | #1 42 [ Siiext 1/d
) : Press [Next] i
Menu (Basic setting mode 3/4) twice / Menu (Basic control setup menu)
t, =3 t

Setup Hode

Basic zetting mode Control

#1 Control action

YN Communication $2 Input setting

N Web,E-Hail #3 DI/DO/SH-reaistration
> #d AUX (Alarm mode. ..}
(L, Time Zame #5 Output processing
#E Rel
Control slaw

#7 Tuning setting

#8 External loop setting

#3102
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Examples of Control Setup Operation

2.
3.

7.

Press the #1 soft key (Control action).

Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and then press the DISP/ENTER
key.

Setup Hode

Control action

PID number “ Loop number[ 1 ——— Select 1
Control period| 25@ms Fanre] mode

2 P off sinsle +—— Select Single

Restart mode

Fixed-point | Cantinue (Slngle |00p)

Froaram Continue Pragren cantrel

Initial PID Tenp o Select Temp

futo tuning [ OFF | oo (Set initial PID to P = 5%,
Follow-Up 1=240s,and D =60 s)

Press the ESC key to return to the basic control setting menu.
Press the Next 1/2 soft key, and then the #5 soft key (Output processing).
Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and then press the DISP/ENTER
key.
To set Cycle time, press the Input soft key to open a numeric entry pop-up window.
Enter the value using the arrow keys and the DISP/ENTER key.

Setup Hode s

Output processing
Loop number 1 Select 1

Select Voltage-pulse
Control output [ Current-output ./ ge-p

Cucle time
Bnalog-output twpe

[—— Setto3s

* No need to set
Analog-output type

4-28nA | B-28mA | 20-dmA | 28-BmA

Press the DISP/ENTER key to confirm the settings.

8. Press the ESC key twice to return to the menu display (basic setting mode 3/4).
9. Press the Next 3/4 soft key to show the menu display (basic setting mode 4/4).

10.Press the End soft key.

A confirmation window shown below opens.

11.Press the DISP/ENTER key to confirm the settings.

12
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Examples of Control Setup Operation

Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu
shown below.

Operation-related parameters/Zone PID

PID parameters

L #2  EER

2. Press the #1 soft key (Control input range).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value, and press the DISP/ENTER key.
To set the measurement span (span lower/upper-limit), press the Input soft key and
use the numeric entry pop-up window that opens.

Select 1

Numeric entry pop-up window

Input ranae Control mode: Single loop
Loog| Mo, |Hode [ T¢ Biss—T] 0L — SelectTC
[1
Tzt Range K e —oii———— Select K
PUl SpanlLower A [ e
Upper e Set to 0.0 Move between digits
— Set to 1200.0 .
Confirm the entry
Sq. root
Press the arrow keys to select these keys
and then press the DISP/ENTER key
Select PV1

4. Press the DISP/ENTER key.
A confirmation window shown below opens.

nt to change

5. Press the DISP/ENTER key to confirm the settings.

IM 04L31A01-04E
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Examples of Control Setup Operation

Setting Control Alarms in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #2 soft key (Control alarm).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric value of the alarm is entered using the pop-up window that appears by
pressing the Input soft key.
Select On  Select PV-High

Select 1 Select PV-Low

Select On

pe Standby Refay Mo, Action
1lad [ PY-Hish 0ff t ponal £xes—y— Select DO001
2lon [ PU-Low off [on [D0BRZ Esers—— Select DO002

SP number 1 Select 1

Alarm value

1 2 3
aea. @ E?B.B

Set to 600.0

Set to 800.0
4. Press the DISP/ENTER key to confirm the settings.

Setting PID Parameters in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #4 soft key (PID parameters).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numerical values such as the SP are entered using the pop-up window that
appears by pressing the Input soft key.
Select 1 Select 1

ol))

Loop number

P [ 7em.@ HResetfEREE

P 5.0 |3 = Keep the initial PID
1 240 7 values for Temp
D [em

Set to 700.0

Output R/D Reverse——————— Select Reverse
Lower| @.8 % Preset a.88
Upper|1aa.a ¥
Shutdown
[off

4. Press the DISP/ENTER key to confirm the settings.

14
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Examples of Control Setup Operation

Control Setup Example 2: Cascade Control
Object of Control and Description

CX1000 Alarm output
DIGITAL OUT1#

—»‘\— High limit temperature alarm
DIGITAL OUT2*

—V‘ Low limit temperature alarm
DIGITAL OUT3*

—»‘— High limit steam pressure alarm

Primary PV input
——

LOOP1 PV!

LOOP2 PV2 |LOOP2 mA3
Secondary
PV input
Pressure
transmitter

TLoop 1 PV input terminal

current output 2 Loop 2 PV input terminal
3 Loop 2 current output terminal

Steam 4 Relay contact output terminal

Primary loop of cascade control

Loop number: 1

PID constant: P=20%,1=300s,D=60s
Control direction: Reverse

Input type: RTD Pt100

Measurement span: 0to 100°C
Temperature setpoint: 80°C

Alarm output: PV high-limit alarm (high limit: 90°C), PV low-limit alarm (low
limit: 70°C)
Secondary loop of cascade control
Loop number: 2
PID constant: P=120%,1=20s,D=0s
Control direction: Reverse
Input type: 1-5V
Measurement span: 0 to 1.00 MPa
Output type: Current output (4-20 mA)
Alarm output: PV high-limit alarm (high limit: 0.90 MPa)

Basic Control Settings

1.

Display the basic control setting menu.

See “Control Setup Example 1” for the steps to show the menu.

AT

Setup Hode

Contraol

#1 Control action

#2 Input setting

#3 DIADO/SH-registration
#d AUX<ATarm mode, ..}

#5 Output processing
#6 Relay
#7 Tuning setting

#8 External loop setting

2. Press the #1 soft key (Control action).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of the value according to the following figure, and press the DISP/ENTER key.

4 to 20 mADC of the control input terminal block
of the control input terminal block
of the control input terminal block

Control valve of the control output terminal block

IM 04L31A01-04E
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Examples of Control Setup Operation

Setup Hode
Control action /Select 1

—— & |Loor number| 1 7] (No need to set loop 2)
Control period| 25@8ms

Control mode

gone PID off tascade —— Select Cascade

Restart mode

Fixed-point | Continue

Froaram Continue Pragren cantrel

Initial PID [PresstFlon—— s Select Tem or
Rut mineg off FID control mode Press+Flow

Follow-Up

4. Press the ESC key to return to the basic control setting menu.
5. Press the Next 1/2 soft key, and then the #5 soft key (Output processing).

Setup Hode

Output processing

Loop number

6. Press the 2 soft key.
There are no control output settings on loop 1 (primary loop of cascade control).

7. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

thernet

Setur Hode :
Output processing
Loop number 2 Select 2
Control output Current-output — Select Current-output
Cucle time | = P
Analag-output twpe | 4-280f ——————————————— Select 4-20mA

* No need to set
Cycle time

Woltage [Current | On/Off
8. Press the ESC key twice to return to the menu display (basic setting mode 3/4).
9. Press the Next 3/4 soft key to show the menu display (basic setting mode 4/4).
10.Press the End soft key.
A confirmation window shown below opens.

11.Press the DISP/ENTER key to confirm the settings.

16 IM 04L31A01-04E



Examples of Control Setup Operation

Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu

Operation-related parameters/Zone PID

PID parameters

L #2  EER

2. Press the #1 soft key (Control input range).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
To set the measurement span (span lower/upper-limit), press the Input soft key and
use the numeric entry pop-up window that opens.
Setting the Input Range on the Primary Loop of Cascade Control
Select 1

BE2 11:1¢
range Control mode: Cascade

Hode [ RTD &+ o Select RTD

Input Range | PT & s Select PT
SpanLower Bl—
Ful —— Set t0 0.0

Upper IBB.B\
[—— Set to 100.0

Sa. rast

4. Press the DISP/ENTER key.
A confirmation window shown below opens.

nt to change

5. Press the DISP/ENTER key to confirm the settings.

6. Set the input range of the secondary loop of cascade control in a similar fashion as
described in steps 3 to 5 and according to the figure below.
If you do not carry out steps 4 and 5 and change Loop number, the settings are not

saved.
Setting the Input Range on the Secondary Loop of Cascade Control

Select 2

L 2AB2 11:28:28
Control mode! Cascade

range

Hode 1-5Y B+as—If—os+—— Select 1-5V
Tupe DY
Tz Range BY  Filter [ off
r“ﬁv?‘“‘ SpanLower | 1,088
Upper | 5,008
Scalelower| @.8@ Set to 0.00
Upper 1.688
Unit TR Set to 1.00
Sq. root — Set to MPa

IM 04L31A01-04E 17



Examples of Control Setup Operation

Setting Control Alarms in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #2 soft key (Control alarm).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric value of the alarm is entered using the pop-up window that appears by
pressing the Input soft key.
Setting Alarms on the Primary Loop of Cascade Control
Select PV-High
Select PV-Low
Select On
Select DO001

Select On Select 1 Select DO002
GRD =

Type Standby Rglav Mo.| Action
ffonl [ PydHish  [orf [of [poka] Enera
2[on PV ow [of [on [poaa? Energ
3ot
dloff
5P number ’1— Select 1
Alarm wvalue
1 2 3 4

50.9 78.9 108, 8

Set to 70.0

Set to 90.0

4. Press the DISP/ENTER key to confirm the settings.
5. Set the alarms of the secondary loop of cascade control in a similar fashion as
described in steps 3 and 4 and according to the figure.
If you do not carry out step 4 and change Loop number, the settings are not saved.
Setting Alarms on the Secondary Loop of Cascade Control
Select 2

Select PV-High
Select On

Select DO003

Select On

£
AB2 11:24:70 %

Logr number

Tupe tandby Reflaw Mp. Action
fflon [ PY-Hish 0ff [on [podez Energ
2loff

3off
dfof

SP nhumber 1 Select 1

Alarm value

1 3 3 4
D 1.0@ 1.0@

l]!lﬂl

Set to 0.90
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Examples of Control Setup Operation

Setting PID Parameters in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #4 soft key (PID parameters).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numerical values such as the SP are entered using the pop-up window that
appears by pressing the Input soft key.
Setting PID Parameters on the Primary Loop of Cascade Control

Select 1

Select 1

SP 8.8 Hk

ol))

Set to 80.0

P 28,8 H—

I 308 ?/7
D &0

Output RAD Reverse
Lowerm%
Upper|188.8 ¥

= Set to P=20.0%, 1=300s,

D=60s

— Select Reverse

4. Press the DISP/ENTER key to confirm the settings.

5. Set the PID parameters of the secondary loop of cascade control in a similar fashion
as described in steps 3 and 4 and according to the figure.
If you do not carry out step 4 and change Loop number, the settings are not saved.
Setting PID Parameters on the Secondary Loop of Cascade Control

Select 1

Select 2

| -
o2 11267 = INE(S)

Loop number

Output R/D [Reverse
Lower| 8.8 % Preset a.88
Upper|188.8 ¥

Shutdown

5P @.88 H.Reset| 5a.0 %

P 128.8
B
D [}

T~

ol))

l— Set to P=120.0% 1=20 s,
D=0s

(No need to change the
settings if the initial PID
values are set for
Press+Flow)

™~ Select Reverse

[oFF

IM 04L31A01-04E
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Examples of Control Setup Operation

Control Setup Example 3: Loop Control with PV Switching
Object of Control and Description
CX1000

TLoop 1 PV input terminal

of the control input terminal block
2 Loop 1 current output terminal

of the control input terminal block
3 Relay contact output terminal

of the control output terminal block

PV1
———
LOOP1 PV1'

LOOP1 PV2'
PV2

A DIGITAL IN®
Distributor PV switching
+ contact input
ALM 1

LOOP1 mA?

4 to 20mADC
current output

\ Control valve

1
Steam EP> [ =

Switching valve

+ Loop number: 1

+ PID constant: P=120%,1=20s,D=0s

+ Control direction: Reverse

* Input type: 1-5 V for both measurement input 1 and 2

* Measurement span: PV input 1: 0 to 300 kg/h, PV input 2: 0 to 30 kg/h
+ PV range conversion: Lower limit: 0 kg/h, Upper limit: 300 kg/h

+ Flow rate setpoint: 100 kg/h

+ Input switching condition: Contact input

Basic Control Settings
1. Show the show the basic control setting menu.
See “Control Setup Example 1” for the steps to show the menu.

Setup Hode

Contraol
#1 Control action
#2 Input setting
#3 DIADO/SH-registration
#d AUX<ATarm mode, ..}
#5 Output processing
#6 Relay
#7 Tuning setting

#8 External loop setting

2. Press the #1 soft key (Control action).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft

key of each value according to the f
Setup Hode i

Control action

PID number g Loop number[ 1 —— Select 1
Control period| 25@ms

Control mode

Zone PID 2 o
oot off PUSwitehins +— Select PVSwitching
estart mode M thad

Fixed-paint | Continue [Sianal |

Program Continue \ ;
Initial PID [PresstFlowd Frogram control Select Slgnal
Auto tuning 0ff

PID cantral made ™ Select Press+Flow

Fallow-Up
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Examples of Control Setup Operation

4. Press the ESC key to return to the basic control setting menu.

5. Press the Next 1/2 soft key, and then the #5 soft key (Output processing).

6. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

Setup Hode

Output processing

Loop number 1

Select 1

Control output
Cucle time

Current-output
| =
Analog-output tvpe 4-28mA

— Select Current-output

— Select 4-20mA

Yol tage [Current | On/0ff

* No need to set
Cycle time

7. Press the ESC key twice to return to the menu display (basic setting mode 3/4).
8. Press the Next 3/4 soft key to show the menu display (basic setting mode 4/4).
9. Press the End soft key.

A confirmation window shown below opens.

10.Press the DISP/ENTER key to confirm the settings.

Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu

shown below.
GROUP

Operation-related parameters/Zone PID

PID paramete

L #2  EER

rs

2. Press the #1 soft key (Control input range).
3. Press the arrow keys to move the cursor (blue) to the Input type box, press the PV1

soft key, and set other parameters as shown in the figure below.
Check that 1 is selected

Inpuf range Control mode: PY switching

Loop [Ho. ([Hode

DCY
BY  Filter [ off
1.me0

1-6V Bias [ 0&f 1 Select 1-5V

5,868
.00 Set t0 0.00
SR Set to 300.00
— Set to kg/h

Tupe
Input Range
r‘“ﬁﬁ?‘“‘ SpanlLower
Upper
Scalelower
Upper
Unit
Sa. root
Select PV1

IM 04L31A01-04E
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Examples of Control Setup Operation

4. Press the DISP/ENTER key.

A confirmation window opens.
5. Press the DISP/ENTER key to confirm the settings.
6. Press the arrow keys to move the cursor (blue) to the Input type box, press the PV2
soft key, and set other parameters as shown in the figure below.
Check that 1 is selected

Inpuf range

Loop |Na. |Hode 1-54 -Bres—oA—+——— Select 1-5V
! Tupe DY
i Range BY  Filter [ off

EE] SpanLower | 1,888

Upper | 5,088
Scalelower @, ip ——  —— Set to 0.00

Upper| 3@.88
Unit oh — Set to 30.00
Sq. root 0ff [ Set to kg/h
Select PV2

7. Press the DISP/ENTER key.
A confirmation window opens.
8. Press the DISP/ENTER key to confirm the settings.
9. Press the arrow keys to move the cursor (blue) to the Input type box, press the
PVrange soft key, and set other parameters as shown in the figure below.
Check that 1 is selected

2o. 1, o I (O]

Input range Control mode: PY switching

Loop |Nao. PV range

l_l Lower 8, p———————— Set to 0.00
Input il 7 | Set to 300.00
PVranae nit

Set to kg/h

l@l

Select PVrange

10.Press the DISP/ENTER key.
A confirmation window opens.
11.Press the DISP/ENTER key to confirm the settings.
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Examples of Control Setup Operation

Setting PID Parameters in Setting Mode

1. From the operation display, click the MENU key to display the control setting menu.
2. Press the #4 soft key (PID parameters).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.

The numerical values such as the SP are entered using the pop-up window that

appears by pressing the Input soft key.

Select 1 Select 1

Set to 100.0

P

S
I 28@:
D R

Output R/D [Reverse
Lower| @.8 % Preset a.88
Upper|188.8 ¥
Shutdown

[orr

= Set to P=120.0%, 1=20 s,

D=0s

(No need to change the
settings if the initial PID
values are set for
Press+Flow)

Select Reverse

4. Press the DISP/ENTER key to confirm the settings.

Control Setup Example 4: ON/OFF Control
Object of Control and Description

TC

PV

| LOOP1 PV'

Electric
furnace

SSR
| I
&

Loop number: 1
Control direction: Reverse
Relay hysteresis

CX1000

TLoop 1 PV input terminal
of the control input terminal block
2 Loop 1 voltage relay contact
output terminal of the control
output terminal block

LOOP1 NC/NO?
ON/OFF
control output

Setpoint: 10.0, activation position: center

Input type: TC K type
Measurement span: 0 to 1200°C
Output type: ON/OFF control output

Temperature setpoint: 700°C

Basic Control Settings
1. Show the basic control setting menu.
See “Control Setup Example 1” for the steps to show the menu.

Setup Hode

Contraol

#1 Control action

#2 Input setting

#3 DIADO/SH-registration
#d AUX<ATarm mode, ..}

#5 Output processing

#6 Relay

#7 Tuning setting

#8 External loop setting

IM 04L31A01-04E
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Examples of Control Setup Operation

2. Press the #1 soft key (Control action).
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

Setup Hode

Control action

PID number 8 Lacp number| 1 —— Select 1

Control period| 25@ms Control mode

cone FID off Sinsle {— Select Single

Restart mode
Fixed-point | Continue

PresrEm | Continue Program control
Initial PID Tene T ol Select Temp
Auto tuning Ooff

PID control mode

Follow-Up

4. Press the ESC key to return to the basic control setting menu.

5. Press the #5 soft key (Output processing).

6. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure, and press the DISP/ENTER key.

Setur Hode
Output processing
Loop number 1 Select 1
Control output [ On/0ff-control  —— Select On/Off-control
Cucle time ms
Analog-output tvpe 4-28mA

* No need to set
Cycle time and
Analog-output type

7. Press the ESC key twice to return to the menu display (basic setting mode 3/4).
. Press the Next 3/4 soft key to show the menu display (basic setting mode 4/4).
. Press the End soft key.

A confirmation window opens.

10.Press the DISP/ENTER key to confirm the settings.
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Setting the Control Input Range in Setting Mode
1. From the operation display, click the MENU key to display the control setting menu

shown below.
i

Operation-related parameters/Zone PID

PID parameters

2. Press the #1 soft key (Control input range).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric values of the lower/upper limit of range are entered using the pop-up
window that appears by pressing the Input soft key.

Input

’T SpanlL

Input range

Select 1

[ -1

Control mode: Single loop

Hode

Range

Sa. root 0ff

Select PV1

4. Press the DISP/ENTER key.
A confirmation window shown below opens.
5. Press the DISP/ENTER key to confirm the settings.

[ T¢ Blee—df—ssi——Select TC
K FiHer——o+—— Select K
ower B — |
Uppsr | 1208 8— | Set to 0.0

— Set to 1200.0

Setting Control Parameters in Setting Mode

1. From the operation display, click the MENU key to display the control setting menu.

2. Press the #4 soft key (PID parameters).

3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
The numeric values of the target setpoint and relay hysteresis setpoint are entered
using the pop-up window that appears by pressing the Input soft key.

Select 1

PID parameters

Loop number

Select 1

[ -]
oop 11.47. - 60> T (O]

1 PID number

SP

Set to 700.0

[ 7e@.8

Husteresis

Yalue 18,

Paos.

— Set to 10.0

RAD Reverse

Preset a.88

\

Select Mid

|~ Select Reverse

4. Press the DISP/ENTER key to confirm the settings.

IM 04L31A01-04E
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Setting the Display Items on the Control Group Display (Control Group Setting)

Below are the procedures for displaying loops 1 and 2 and measurement channel (input
channel for measurement) 1 and 2 on the control group display (group name: CONTROL
GROUP 1) of group number 1.

1. From the operation display, click the MENU key and then the Next 1/2 soft key to
display the control setting menu 2/2 shown below.
Menu (Setting mode (Control) 1/2)

—>

Operation-related parameterss/Zone PID Detailed setting

PID parameters

i1 ho ST et 12 B 65 i R

2. Press the #5 soft key to show the Control group setting display.
3. Press the arrow keys to move the cursor (blue) to the setup item box, press the soft
key of each value according to the following figure.
Select On

Select Int-Loop or Meas CH
If internal loop, select the loop number.
If measurement channel, select the channel nhumber.

Contro| aroud
Group |number
Group [name CONTROL GROUP1L

Kind Hao Tag Tag comment
On |Int-Loop| 81 INT-@1

On |Int-Loop| 82 INT-B2

On |Heas-CH | 81 81

On |Heas—CH [IEE 92

oW R

— Control status
display of
internal loops
1and 2

Measured value
of measurement
channel 1 and 2

RUNASTP | TUWING

26
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Displaying the Trend of PV, SP, and OUT Values

Below are the procedures for displaying the trends of PV, SP, and OUT of loop 1 and the
values of measurement channels 1 and 2 on the trend display of group number 1 (group
name: GROUP 1).
1. From the operation display, open the Group set, Trip line setting display according to
the following procedure.
Press the MENU key (to switch to Setting mode (Control)) and then the MENU key
(switch to Set mode). Press the #5 soft key (to select Display) and then the #1 soft
key (to select Group set, Trip line).
Menu (Setting mode (Control)) Menu (Set mode 1/2)

! g 1ol NEXEE(O) 6

Operation-related parameterss/Zone PID Trend/5ave interval,lUser kew

PID parameters Hesszage

EETNENTE

[ w1 w2 T et 1/3

Menu (Set mode 2/2) Menu (Display)

o0 b (O )Y 115701 b= NEEEEN (SR
Dizsplay

#1 Group set,Trip line
#2 Calor
#3 Zone, Grarh
#d Wiew,Direction,LCD

SavefLoad,Clear data #5 Control (Color?

_ #6 Control {Zone, Graph?

Tioe #7 Hath (Color)

#8 Hath{Zone, Graph?

Group number rr

Group set

Group name |GROUP 1
CH set

Trip line
1 Off
2 Off
3 Off
4 Off

3. Press the Input soft key to open the channel input pop-up window.

4. Use the arrow keys and the DISP/ENTER key to select the channels to include in
the group.
In this group setting, the PV, SP, and OUT of loop 1 are assigned channel numbers
101, 102, and 103, respectively. To include PV, SP, and OUT of loop 1, enter 101-
103 or 101.102.103. For measurement channels 1 and 2, enter 01.02.

IM 04L31A01-04E
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Displaying the Trend of PV, SP, and OUT Values

Enter 101-103.01.02

— Channel input
pop-up window

key.
Group number rf
Group set
Group name |[GROUP 1
cH set [tB1-183.81.82
Trip line
1 Off
2 0ff
3 0ff
4 0f f

6. Press the DISP/ENTER key to confirm the entry.

Note
You can select up to 10 channels from measurement channels (CH1 to CHO6), computation
channels (CH31 to CH42), internal control channels (CH101 to CH106), and external control
channels (CH201 to CH212) using Channel setting.

» Assignment of internal control channels (channels of internal loops)
The data of two loops is assigned to channel numbers as follows:
Loop 1 PV: 101, Loop 1 SP: 102, Loop 1 OUT: 103
Loop 2 PV: 104, Loop 2 SP: 105, Loop 2 OUT: 106
Assignment of external control channels (channels of external loops)
The data of four loops is assigned to channel numbers as follows:
External loop 1 PV: 201, External loop 1 SP: 202, External loop 1 OUT: 203
External loop 2 PV: 204, External loop 2 SP: 205, External loop 2 OUT: 206
External loop 3 PV: 207, External loop 3 SP: 208, External loop 3 OUT: 209
External loop 4 PV: 210, External loop 4 SP: 211, External loop 4 OUT: 212
Set the channels to assign them to a group according to the following rules.
Enter the channel number using two or three digits.
Separate each channel with a period.
Use a hyphen to specify consecutive channels.

Iminddiv
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Switching the Operation Mode

For details on the procedure for switching the operation mode, see chapter 6,
“Operations during Control Operation” in the CX7000 User’s Manual (IM 04L31A01-03E).
The following is a procedural example on the control group display.

Run/Stop Operation
For cascade control, the following operations can be performed only when the secondary
loop is selected.
1. Use the arrow keys to move the cursor to the desired control loop.

Cursor (9)

2. Press the RUN/STP soft key.

A pop-up window for running and stopping the operation appears.
INT-A INT-82

RUN/STP = RUN [0 Window for starting and

stopping operation

3. Select RUN or STOP using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Switching between Auto, Manual, and Cascade Control
You can only switch to the cascade mode on the secondary loop of cascade control.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the Mode soft key.

The MODE selection pop-up window appears.
INT-A1 INT-82

HUT MODE selection window
3. Select AUT (auto), MAN (manual), or CAS (cascade) using the up and down arrow
keys.
4. Press the DISP/ENTER key to confirm the changes.
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Switching the Operation Mode

Changing the Target Setpoint
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the SP soft key.
The SP modification pop-up window appears. The window shows the current target

setpoint.
INT-A1 INT-82
BUT L ] AUT

Window for changing the
target setpoint

3. Change the target setpoint using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Changing the Control Output
The following operation cannot be performed during auto operation, when operation is
stopped, or when the primary loop of cascade control is selected. When the operation is
stopped, the preset value is output.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the OUT soft key.
The OUT maodification pop-up window appears. The window shows the current
control output.

iT— Window for changing the
control output
3. Change the control output using the up and down arrow keys.
The control output is set to the new value at this point.
4. Press the DISP/ENTER key to complete the procedure.
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Switching the Operation Mode

Switching between Remote and Local Modes
The soft key menu does not show REM/LOC, if Control > Contact input-registration/
AUX(Alarm mode... > Remote setting is set to Off. Remote input cannot be used for the
target setpoint when the secondary loop of cascade control is selected or during program
control. Thus, there is no remote/local switching in these cases.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the REM/LOC soft key.

A pop-up window for switching between remote and local appears.

REM/LOC = LOCAL |54 Window for switching between
remote and local
3. Select REMOTE or LOCAL using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Switching between Automatic and Manual for the Analog Retransmission Loop
You can switch the output mode for the control loop specified for analog retransmission.
When set to AUTO, the computed result of analog retransmission is output. When set to
MAN, you can set the direct output value.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the MODE soft key.
A pop-up window switching between auto and manual appears.

INT-A1 INT-@2

b = arSH=—— Auto/manual switching window

3. Select AUTO or MAN using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.
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Switching the Operation Mode

Changing the Analog Retransmission Output
MAN must be set for the MODE using the procedure above.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the OUT soft key. The Output Value Setting window appears.

MODE| oot = o2

3. Change the output value using the up and down arrow keys. The currently set
control output value is displayed in the window.

Switching between Automatic and Manual for the DIO Operation Monitoring
You can switch the output mode for the DO specified in the DIO Operation Monitoring

Function. When set to AUTO, the internal switch status is output. When set to MAN, you

can switch the direct output value between 0 and 1.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the MODE soft key.

A pop-up window switching between auto and manual appears.
20UP1 3

Hith -5 Auto/manual switching window

3. Select AUTO or MAN using the up and down arrow keys.
4. Press the DISP/ENTER key to confirm the changes.

Changing the DO Output for the DIO Operation Monitoring
MAN must be set for the MODE using the procedure above.
1. Use the arrow keys to move the cursor to the desired control loop.
2. Press the OUT soft key. The Output Value Setting window appears.

MODE| oot = o2

3. Change the output value using the up and down arrow keys. The currently set
control output value is displayed in the window.
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Tuning Operation

For details on the procedure of switching the operation mode, see chapter 6, “Operations
during Control Operation” in the CX71000 User’s Manual (IM 04L31A01-03E).
Displaying the Tuning Display
Press the TUNING soft key on the control group display.
o2 11154113 R Ex(d) ;

GRF Mo=1 FL

Auto Tuning
To execute auto tuning, Basic setting mode > #12 Control > #1 Control action > Auto
tuning must be turned On before carrying out the following procedure.
1. Press the AUTO TUN soft key on the tuning display.
As shown in the following figure, the auto tuning setup pop-up window appears along

with a warning message.
INT-8 el T )
—

JEMT]
/8y, WARNING!

then on-off control is being used, suto-tunig can
not be carried out, Horeover, do not perform auto-
tuning when controlling any of the following cases
- Control process with aquick response such as
flow control or pressure control
- Process where even temporary output onfoff
results in inconvenience
- Process where a large output change at control
element results in inconvenience
- Process where variations in PV may exceed an al-
lowable range, adversely effecting product guality

AUTOTUN [GROUP] AT =| 1[5 NERT 2/2 |

INT-A1

Auto tuning setup window
2. Select the control loop using the up and down arrow keys.

AUTOTUN [GROUP] AT = 1[5 NERT 2/2 |

3. Press the DISP/ENTER key to execute auto tuning.

CAUTION

» You cannot execute auto tuning during ON/OFF control.
+ Do not execute auto tuning when controlling the following types of processes. If
you do, malfunction may occur in the control process.
« Control process with fast response such as flow control and pressure control.
+ Processes that result in adverse consequences when the output is turned on/off
even if temporarily.
* Processes that result in adverse consequences if a large output change is
applied to the control element.
+ Processes that may cause adverse effects on the quality of a product when the
process value exceeds the allowed fluctuation width.
. ___________________________________________________________________________________________________|
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Tuning Operation

Manual Tuning
1. Press the arrow keys on the tuning display.
A cursor appears in the control parameter display section.
2. Select the control parameter you wish to change using the arrow keys.
3. Press the DISP/ENTER key.
The parameter modification pop-up window appears.
Cursor

Control parameter
dislay section

PID Mo=1 GRP Ho=1 FU S0 OUT

Window for changing parameters

4. Change the value using the up and down arrow keys.
5. Press the DISP/ENTER key to confirm the changes.
To close the window without making any changes, press the ESC key.
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Program Control Function (/PG1 and /PG2 Options)

Program Control Function Introduction

Program control function is used to ramp-up or ramp-down the SP according to a
program pattern. The number of program patterns that you can create with the CX1000

is as follows:
+ /PG1 option: 4
+ /PG2 option: 30

Up to 99 segments can be specified in a single pattern.

sp—

/PG1: 4 patterns
/PG2: 30 patterns

——
Segment

Operation Mode during Program Control
The following 4 types of operation modes are available.

—— e ——

Reset mode s Rethlet. Local operation mode
The program control of all loops is stopped. tol p alf foops. When switched to local operation mode
All event outputs are cleared (off). - even during program control,
Start loop fixed-point operation is carried out
operation. according to the SPs specified locally.
Start Reset. Start Switch Switch the loop to local.
program control. g:':pp;ﬁ?;z?st.o reset. program control the loop End program to local.

Program control mode
Control operation is being carried out
according to the program pattern.

Time —

to program control.

Hold operation mode

Clear hold. The raising or lowering of the SP
B E— according to the program pattern
—_—

Execute hold.

during program control
is forcibly held such as through key operation.

Program in operation

Operations on the Program Selection Display (See the figure on the next page)
Displaying the Program Selection Display
On the control group display or control overview display, select CONTROL >
PROGRAM from the screen selection menu.

Starting Program Control
Program control starts, and the screen switches to the Program Control Display.
1. On the Program Selection Display, press the RUN soft key.
A pop-up window for starting the program control appears.

RUM

FT @RUN = RUN |5¢ hEFﬂ?TI_

2. Press the DISP/ENTER key.

Window for starting
the program control

—_———————
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Program Control Function (/PG1 and /PG2 Options)

Program Selection Display Example
Program pattern name ——{gg = o i ic |t

Fpr
28mlinSdiy .

Target SP display of the

Repeat frequency selected segment*

Preset pattern waveform
The selected segment

Selected pattern number Segment range to be repeated

Start segment number display
Selected segment* number—

— Display the program pattern
control start delay time

Selected segment* time
Show the program control display
* The selected segment is the (valid only during program control)
segment displayed at the Settings for pattern to be run as a result of communication function,
left end. Select the segment DI/DO, or internal switch action
using the left and right Switch the program pattern
arrow keys. Display the window for starting the program control
Soft key menu 2/4
EV_ON/OFF[ EV KIND [OVERVIEW [CTRL IaRP [NEXT 274 |

Switches to control group display (style number S3 or later)
Switches to overview display (style number S3 or later)
Display the window for the selection menu for the event display method

(style number S3 or later)
Turns the event display ON/OFF (style number S3 or later)

Soft key menu 3/4
ST SEG [ DELAY TH [ ALL/DTY [DSP LOOP [NEXT 3/4 |

Display the ON/OFF selection menu of program
pattern display loops
Switch full display/split display
Display the window for setting the program pattern control start delay time

Display the window for setting the program pattern Soft key menu 3/4
start segment

Soft key menu 4/4
-1B5EG | +1@5EG Ima,flcrﬂ | NEXT 4.4

Switch tag/tag comment display
Shift the displayed segment by +10 segments
Shift the displayed segment by —10 segments

Operations on the Program Control Display (See the figure on the next page)

Displaying the Program Control Display
When you start the program control on the program selection display, the program
control display appears. You can display the program control display when program
control is in progress by selecting CONTROL > PROGRAM from the display
selection menu on the control group display or the control overview display or
pressing the RUN PNL soft key on the program selection display.

Executing and Clearing the Hold Operation
You can hold the progress of the program (stop the timer). While in hold, you can
change the segment SP or increase or decrease the remaining segment time.

1. Press the HOLD soft key.
A pop-up window for executing/clearing the hold operation appears.

RUN/RST | nDu Wlnd_ow for executing/ .
clearing the hold operation.

2. Select ON (execute) or OFF (clear) using the up and down arrow keys.
3. Press the DISP/ENTER key.
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Program Control Function (/PG1 and /PG2 Options)

Resetting Program Control
Resets the program control and stops.
1. Press the RUN/RST soft key.
A pop-up window for starting and resetting program control appears.

— Window for starting and
mnuw resetting program control
2. Select RESET using the up and down arrow keys.
3. Press the DISP/ENTER key.

Program Control Display Example
Cursor indicating the program execution position
Control pattern number display

Program pattern name Tag/Tag comment display

Preset pattern waveform
(SP, dotted line) \
PV waveform (solid line)*

Control segment number —___

PV, SP, and OUT display

Displays wait time when in
wait mode

_— Repeat frequency and

i repeat count values

“— Repeat segment range

— Remaining time display of

Control mode

HOLD (blinking): Hold mode the control segment
WAIT: Wait mode Show the program selection display
DELAY: Program pattern Hold the program

Advance the program

controlled being | . ' i
Display the window for starting program control and resetting

delayed

* PV waveforms are displayed ~ Soft key menu 2/3
when youpress the START EW_QN/OFF| EY KIND | OVERVIEW |CTRIL GRP [ MEXT 2/3 |

key t‘i) isttial;: :h?:amt rnal Switch to control group display (style number S3 or later)
acquisition to the interna Switch to overview display (style number S3 or later)
memory. Display the selection menu for the event display method
(style number S3 or later)
Turn the event display ON/OFF(style number S3 or later)

Soft key menu 3/3
ALL/DIY | DSPy LooP | Tnalcrﬂ | NEXT 3/3 |

Switch tag/tag comment display

Display the ON/OFF selection menu of program pattern display
loops

Switch full display/split display

Soft key menu when in hold mode
RUM/RST | ADVAMCE | HOLD |SEGiTIHE [MEXT 143 |

Display the window for changing the remaining segment time

TSFI CHG [ SEL PML_[EW OM/OFF[ EW KIND [MEXT 2/4 |

Display the menu for selecting the loop of which
the target SP is to be changed

OVERVIEW [CTRL GRP [ ALL/DIY [DSP_LOOP [MNEXT 374 |

TAGACHT HEXT d/d

Switching between Program Control and Local Control for Each Loop
Press the PRG/LOC soft key on the control group screen to switch between program
and local.
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Program Control Function (/PG1 and /PG2 Options)

Executing Several Program Patterns
You can execute multiple program patterns whose loop numbers do not overlap.
Switching Pattern Numbers
1. Press the PT NO. soft key in the program selection screen.
The pattern number switching pop-up window appears. The currently set pattern
numbers are displayed in the window.
2. Select a pattern number using the up and down arrow keys.
3. Press DISP/ENTER key to confirm the changed settings.
To close without saving, press the ESC key.

Program Operation Start
1. Press the RUN soft key.
The program operation start pop-up window appears.
2. Press the DISP/ENTER key. The screen changes to the program operation display.

Displaying the Program Selection Display
1. Press the SEL PNL soft key.
The screen changes to the program selection display.

Executing a Separate Program Pattern
1. Repeat the above procedure as necessary.

Switching the Displayed Pattern in the Program Operation Display
1. Press the left or right arrow keys to switch the displayed pattern.

Program Control Setup Operation
Program Control Setup Operation Sequence
First, set the control functions of the loops to be used (see below). Next, set the
program control (see page 39).

Setting the Control Operation of the Loops to Be Used

This section explains only the settings specific to the program control.
+ Control > Control action setup screen

For a description of the setup procedure, see pages 11 and 12.

3

Setup Hode
tontrol action Select the operation status when a power
PID nunber  [NRNENNN |Loor number| 1 failure occurs during program control and
Control period| 258ms the power recovers.
Control mode s s
Zaone PID 0ff [ srale « [Continue]: Continues program control.
Restart mode « [Manual]: Switches the loop to manual
Fixed-point [ Continue operation.
Prosrem | Continue o . e control +[Reset]:  Resets program control.
Initial PID Tenp on
fefin Sl off FID control mode
Follow-Up Select [On]. j
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Program Control Function (/PG1 and /PG2 Options)

Program Control Related Setup Operations
Follow the flow chart below.
For further details on each function, see section 1.11, “Program Control Related
Settings” in the CX71000 User’s Manual (IM 04L31A017-03E) provided on the
accompanying CD-ROM.

MENU key (switch to the Setting mode (Control))
> Next 1/2 soft key

)
Program-control parameters Setting mode{Control’
#1 Program parameter setting #7 P ol srous setting—
#2 Event output zetting B —
#3 Auxifuto message,Display position? L Ten-seament linearizer 1/
> #d  Aux{Event group} Program-control parameter

Detailed setting

[#7 Program-control parameters] appears
only if you set [Program control] to [On]
under [Control action] on page 38.

DISPENTER key |#1(D

4 Eno o
#1 Pattern initial setting
Program parameter setting Frogram initial setting
#1  Pattern initial setting @ PaittErn mumber
#1 Seagments a
=l > Segment setting method Time
Pattern name Pattern 1
A CRUTION fction loop Loop 1 off
You must press the DISP/ENTER kev to ESC key*2
confirm the item indicated in wellow -
on the #1 Pattern initial setting diselay +— Remaining ecments S0
before vou can edit the pattern settings. Remaining events gee

*1
#1/' Select pattern number and
/ then change the settings.
END o :
@ Program parameter setting ESC key*2 Frogram initial =zetting

F : Pattern number
#1 Pattern initial setting ——
. . . DISP/ENTER Seagments q
#2 Wait action setting X .
. key Segment setting method Time
#3 Pattern start setting
- l Pattern name Pattern 1
#d Froaram pattern setting ESC k
. ey
#5 Event setting
#6 Hysteresiz (PY event: Action loop Loop 1 0n
#7 Repeat action setting
ER To set a single pattern, carry out steps 1 to 8. fenaining sesnents 308
enaining events gee
#2 #3 Next 142
+#2 to #7 @ 4 ESC key *1 If you set pattern parameters of other numbers

Change the settings on setting screens after this step, all settings up to that point are

#2 to #7. cleared.
*2 If you did not change the settings on the Pattern

initial setting screen

Setup Sequence
First, enter pattern initial settings (1 to 4 above).
Next, set [#2 Wait action setting] through [#8 Repeat action setting] (5 and 6 above).
Return to the Program-control parameters screen (7 and 8 above).
Set [#2 Event output setting] and [#4 Aux (Event group).]

Refer to the figure above for the following procedures.
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Program Control Function (/PG1 and /PG2 Options)

Pattern In|t|al Setting

Prosram |n|t|a] zet

ting

Enter the program pattern number.

Pattern name
Seagment edit mode

FPattern number _/
Seagments ———r3
Segment setting method Tlme

Pattern

0Ff \

Enter the number of segments to be used.

[ /PG1:1to 4,/PG2:1 to 30
[ 11099

Remaining segments
Remaining events

\( Enter the pattern name (up to 16 characters).

(Segment setting method:Time)

Select the time or ramp-rate (see below). )

N
m Specify the position of the segment to be
deleted or added.

(Segment setting method: Ramp-rate)

Target SP Method for creating the

segment using

l<—> Segment time

the target

SP and the segment time.

Method for creating the segment

using the target SP and the

ramp-rate of the SP change.

Set the ramp-rate using rate-of-

change per minute (example:

/ 2°C per minute) or rate-of-change
per hour (example: 10°C per hour).

Target SP

Wait Action Setting
Set 5 types of wait actions. Specify the wait action for each segment.

Minute or hour Rate—of-change

Select [On] to set a wait zone. )

Set the wait zone (engineering unit).

L[ a1

Loop2 [ofF  [off  [ofF  [oFF  [oFf.
H

L

Wait time
A : B8 88

Enter the maximum wait time when using the

@Vait function at the time of segment switchingD

Segment 1 Segment 2
Target SP ---1"-~
4 .

2

/ Wait zone low

Wait zone high

sP_/
, Actual wait time
g | Wait time

/ PV (specified value)

@Vait function within the segment)
l Wait zone high
Y, Wait zone low

“sp

/43 —— Wait time

wait function at the time of segment switching
(see below).

If the PV is outside the wait zone when the SP reaches the target SP
of the segment, the program does not advance to the next segment.
When the PV enters the wait zone, the program advances to the next

segment.
not enter

In addition, when the wait time elapses even if the PV does
the wait zone, the program advances to the next segment.

If the wait zone is set to 00:00:00, the program does not advance to
the next segment until the PV reaches the wait zone.

The advancing of the program control stops when the SP exits from
the wait zone. When the PV returns within the wait zone, the
advancing of the program control resumes. [Segment time] setting
is irrelevant for wait within the segment. The advancing of the
program control is stopped until the PV reaches the wait zone.
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Program Control Function (/PG1 and /PG2 Options)

Pattern number: 1 /( Enter the SP of the pattern start point. )

Start taraet setpoint
Loop 1

Loop 2 -208. 8
Start code StartTargetsSP N

Select the operation when starting the program
control (see below).

Input

Select the operation start condition (Start code) from the following.

( Start code: StartTargetSP)

Starting SP Start

Targi»SP Program starts from the starting target SP.

Ramp-rate of the SP change
Starting (specified value)
target SP

l<—> Segment time (specified value)

(Start code: RampPV1Start to RampPV6Start )

Ramp-prioritized PV1 to PV6 start

The program control starts from the SP corresponding
to the PV (PV1 to PV6) of the specified loop. For other
PV at the start [l Starts from this SP. loops, the program control starts from the same point
of control L’ as the start point of the specified loop. The ramp-rate
. of the SP change is maintained as specified. The
segment time is shortened.

Target SP
|—>

Actual segment time
Segment time (specified value)

(Start code: TimePVStart )

Target SP Time-prioritized PV start
Ly aee The program control starts from the SP corresponding
/” /r to the PV of each loop. The segment time is maintained
PV at the start . ;\ as specified. The ramp-rate of the SP change varies
of control 7 —— Starts from this SP. depending on the position of the PV.

Segment time (specified value)
Segment time (specified value)
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Program Control Function (/PG1 and /PG2 Options)

Program Pattern Setting
+  When the segment setting method is set to [Time]

; Select the segment number. )| o Soak ’
Program pattern zetting
Seament number - Ramp/Soak se]ect Ramp/( Select ramp or soak.
Target setpaint —( Enter the target SP of the segment. )
Loor 1 [ -260.8 M]’—'zaﬁ— -
Segment tine 05 :09: a1 /’( Enter the segment time. )
Select the PID number to be used J
N T /{ (Not displayed when zone PID is selected).
Szament shift action | continue —— Select the operation when ending the segment.
it aetien Shift \ « [Continue]: Advance to the next segment.
ol Esie muniep LN - [Hold]: Hold the program progress.

Input vent « [Local]: End by setting the loop to local mode.
- [Reset]: End by stopping the loop.

Select the wait action type (see page 40). )

Select the wait zone number to be applied. )

*  When the segment setting method is set to [Ramp]
& 1n.|_ ( ||_|§-I11 3 HEDW _

Program pattern setting Pattern number:

Segment number - Ramps/Soak select Ramp

Target setpoint

Y/
Loop 1 -268.8 Loop 2 -208.8 “ Select the ramp time unit.

Same as the figure above.

« [Hour]: 1 hour
Ramp-rate time unit Hour ——"———————

« [Minute]: 1 minute

Ramp B, 1

Segment PID group Mo, 1 ot at .
Seament shift action | ontinns L Entgr the_ rate-o_f-change per unit time using
Wait action 0ff engineering unit.

~— O

Same as the figure above.

Input

Event Setting
. When the event kind is set to [TimeEvent]

Select the segment number to which the event
Euent settlns is to be assigned.
FPattern numbeg -
Seanent No f'/F E—— L Select [TimeEvent] (see below). )
. [ont —taa:an.00 [a0:20:00 { Select the type of time event ([On/Off], [On/**], ]
Event kind 2|0n2 | BA:00:088 o
’mg{ 3[ons (506000 or [**/Off]) (see below).
Set the time for turning ON/OFF the contact
output in terms of the time elapsed from the
start point of the segment (see below).
Input e { Select the event number range, [1-8] or [9-16]. )

Time event is a function used to turn ON or OFF the contact output after a specified
time elapses by starting the clock from the time the segment operation is started.

Up to 16 time events can be specified for each segment. There are 3 types of time events.

Type of time event [On/Off] [On/**] [**/Off]
, Segmentn, n+1 Segmentn . n+1 ! Segment n

Event output _,I: E ' :
On- time : On-time -

Off-time —————>

n+1

]

Off-time —— >
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Program Control Function (/PG1 and /PG2 Options)

+ When the event kind is set to [PVEvent]
o 172003 1402100 01 M (@)
Event setting
FPattern number

Segment No i |eererp—Top TETUE
/ 1 I =TT, I 1278 3

Event kind

PVWEven

Select the segment number to which the event
is to be assigned.

Select [PVEvent] (see below).

assigned.

Enter a value when the PV event is to be

N
ort \{ detected using engineering unit.
N\( Select the type of PVEvent (see below).

m-am/t.n-l:-wl\:

Select the loop to which the event is to be ]
Select the event number range, [1-8] or [9-16]. )

Input

This function outputs preset alarms such as PV alarms, SP alarms, and output
alarms during program operation. Up to 16 PV events can be specified for each
segment. PV events operate only within the specified segment.

PV high-limit alarm (PV-H) example Select the type of PV events from the following.

» PV-H (PV high-limit), PV- L (PV low-limit),
-/ Set value

Dev-H (deviation high-limit), Dev-L (deviation low-limit),
SP Dev-H&L (deviation high & low limit),
PV and D-W-H&L (deviation within high & low limits)
+ SP-H (SP high-limit) and SP-L (SP low-limit)
» Out-H (output high-limit) and Out-L (output low-limit)

Event output

Event Output Destination Setting
The even output destination is set using the Event output setting display (see
[Program-control parameters] display on page 39).

Repeat Action Setting

3 oL GROUPL = i
; b ENR) Select [On] or [Repeat] when using the repeat
Repeat setting - action.

Pattern number: 1 / * [On]: Repeats the specified number of
Repeat action “ times
Repeat fredquency N « [Repeat]: Repeats infinitely

Repeat start seament 3
Repeat end seament 5 N

"~ Enter the number of repetitions when [Repeat
action] is set to [On].

Repant ( Set the range of segments to be repeated. J

Repeat action

Pattern created Pattern executed

Execute segment 3to 5
twice (repeat frequency: 2)

Executed twice
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List of Parameters

Below is a list of parameters for the model with the various function options. However,

settings related to the program control function option are not given.

Basic Setting Mode

#1 Alarm
Parameter Selectable Range or Selections Initial Value
Alarm > Reflash On/Off Off
Alarm > Relay > AND None, 101, 101-102, 101-103, ... , or 101-106 None
Alarm > Action Energize or Deenergize Energize
Alarm > Behavior Hold or Nonhold Nonhold
Alarm > Indicator Hold or Nonhold Nonhold
Alarm > Rate of change > Increase/Decrease 1t0 15 1
Alarm > Hysteresis On/Off On
#2 A/D, Temperature
Parameter Selectable Range or Selections Initial Value
A/D Integrate > Integrate Auto, 50 Hz, 60 Hz, or 100 ms Auto
A/D > Scan interval 1sor2s 1s
A/D > First-CH 01 to 06 01
A/D > Last-CH 01 to 60 01
A/D > Burnout set Off, Up, or Down Off
A/D >RJC Internal or External Internal
A/D > Volt (uV) —20000 uV to 20000 uV ouv
Temperature > Unit CorF C
#3 Memory
Parameter Selectable Range or Selections Initial Value
Memory > Save Manual or Auto Auto
Memory > Data Display, E+D, or Event Display
Memory > Event > Sample rate 1s,25,565,10s,30s,60s,120s,300s,0r600s 1s
Memory > Event > Mode Free, Trigger, or Repeat Trigger
Memory > Event > Block 1,2,4,8,0r16 1
Memory > Event > Data length 3 minutes to 31 days 1h
Memory > Event > Pre-trigger 0, 5, 25, 50, 75, 95, or 100 0
Memory > Event > Trigger > Key On/Off On
Memory > Event > Trigger > External On/Off Off
Memory > Event > Trigger > Alarm On/Off Off
#4 Memory and Trend, Memory Timeup
Parameter Selectable Range or Selections Initial Value
Memory and trend > Meas/Math/Loop CH Meas CH, Math CH, Int CH, or Ext CH Meas CH
Memory and trend > First-CH Meas CH: 01 to 06, Math CH: 31 to 42, 01
Int CH : 101 to 106, or Ext CH: 201 to 212
Memory and trend > Last-CH Meas CH: 01 to 06, Math CH: 31 to 42, 01
Int CH : 101 to 106, or Ext CH: 201 to 212
Memory and trend > On/Off On/Off On
Memory timeup > Timeup type Off, Hour, Day, Week, or Month Off
Memory timeup > Date 11028 1
Memory timeup > Time (hour) 0to 23 0
#5 Keylock
Parameter Selectable Range or Selections Initial Value
Keylock > Use/Not Use/Not Not
Keylock > Password Up to 6 alphanumeric characters -
Keylock > Keys such as START Free or Lock Free
Key lock > Soft keys such as ALARM ACK Free or Lock Free
Key lock > Control settings such as the input range Free or Lock Free
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List of Parameters

#6 Key login
Parameter Selectable Range or Selections Initial Value
Key login > Use/Not Use/Not Not
Key login > Auto logout On/Off Off
Key login > UserID Use/Not Use/Not Not
Key login > Number 1,2,3,4,5,6,0or7 1
Key login > On/Off On/Off On
Key login > User name Up to 16 alphanumeric characters user1
Key login > User ID Up to 4 alphanumeric characters 1
Key login > Password Up to 6 alphanumeric characters -
Key login > setup On or Off On
#7 Load, Initialize...
Parameter Selectable Range or Selections Initial Value
Load, Initialize > #1 Load settings - -
Load, Initialize > #2 Delete - -
Load, Initialize > #3 Format - -
Load, Initialize > #4 Initialize > Kind Clear1 to Clear3 Clear3
#8 Option
<#1 Remote>
Parameter Selectable Range or Selections Initial Value
Remote > Action No. 1 to No. 8 None, MemoryStartStop, Trigger, AlarmACK, None
TimeAdjust, MathStartStop, MathReset,
Manual sample, Panel1Load, Panel2Load,
Panel3Load, Message1, Message2,
Message3, Message4, Message5,
Message6, Message7, Message8,
Snapshot
<#2 Report>
Parameter Selectable Range or Selections Initial Value
Report > Report set Off, Hour, Day, Hour+Day, Day+Week, or Day+Month Off
Report > Date' 1to 28 1
Report > Day of the week? SUN, MON, TUE, WED, THU, FRI, or SAT SUN
Report > Time(hour) 0to 23 0
Report > Report CH RO1 to R12 RO1
Report > Off/On On/Off On
Report > Channel 01 to 06, 31 to 42 01
Report > Sum scale Off, /s, /min, /h, or /day /s
"When the report type is monthly report
2When the report type is weekly report
<#3 Timer (TLOG)>
Parameter Selectable Range or Selections Initial Value
Timer(TLOG) > No. 1t03 1
Timer(TLOG) > Mode Off, Relative, or Absolute Absolute
2 and 3: Off
Timer(TLOG) > Interval 1 min, 2 min, 3 min, 4 min, 5 min, 6 min, 10 min, 12 min, 1h
15 min, 20 min, 30 min, 1 h,2h,3h,4h,6 h, 8 h, 12 h,
or24 h
Timer(TLOG) > Ref.time 0:00 to 23:00 0:00
Timer(TLOG) > Reset On/Off Off
Timer(TLOG) > Action Off or DataSave Off
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List of Parameters

#9 Communication
<#1 Ethernet (IP_Address)>

Parameter Selectable Range or Selections Initial Value
Ethernet (IP_Address) > IP-address - 0.0.0.0
Ethernet (IP_Address) > Subnet mask - 0.0.0.0
Ethernet (IP_Address) > Default gateway - 0.0.0.0
<#2 Ethernet (DNS)>
Parameter Selectable Range or Selections Initial Value
Ethernet (DNS) > DNS On/Off On/Off Off
Ethernet (DNS) > Server search order > Primary ~ — 0.0.0.0
Ethernet (DNS) > Server search order > - 0.0.0.0
Secondary
Ethernet (DNS) > Host name Up to 64 alphanumeric characters -
Ethernet (DNS) > Domain name Up to 64 alphanumeric characters -
Ethernet (DNS) > Domain suffix search order > Up to 64 alphanumeric characters -
Primary
Ethernet (DNS) > Domain suffix search order > Up to 64 alphanumeric characters -
Secondary
<#3 FTP transfer file>
Parameter Selectable Range or Selections Initial Value
FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
<#4 FTP connection>
Parameter Selectable Range or Selections Initial Value
FTP connection Primary or Secondary Primary
FTP connection > FTP server name Up to 64 alphanumeric characters -
FTP connection > Port number 1 to 65535 21
FTP connection > Login name Up to 32 alphanumeric characters -
FTP connection > Password Up to 32 alphanumeric characters -
FTP connection > Account Up to 32 alphanumeric characters -
FTP connection > PASV mode On/Off Off
FTP connection > Initial path Up to 64 alphanumeric characters -
<#5 Control (Login, Timeout)>
Parameter Selectable Range or Selections Initial Value
Ethernet login > Use/Not Use/Not Not
Ethernet login > Level admin, user1, user2, user3, user4, user5, admin

or useré
Ethernet login > Level > On/Off On/Off On
Ethernet login > Level > User name Up to 16 alphanumeric characters admin
Ethernet login > Level > Password Up to 6 alphanumeric characters 0
Application time out > On/Off On/Off Off
Application time out > Time 110120 1 min
Keep alive > On/Off On/Off On
<#6 Serial, Memory out>
Parameter Selectable Range or Selections Initial Value
Serial > Baud rate 1200, 2400, 4800, 9600, 19200, or 38400 bps 9600 bps
Serial > Data length 7o0r8 8 bit
Serial > Parity Odd, Even, and None Even
Serial > RS-232 > Handshaking Off:Off, XON:XON, XON:RS, or CS:RS Off:Off
Serial > RS-422/485 > Address 1to 32 1
Serial > RS-422/485 > Protocol Normal, Modbus, Modbus-M, or Ladder Normal
Memory output Ethernet or serial Ethernet
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<#7 Modbus master (BASIC)>

Parameter Selectable Range or Selections Initial Value
Basic settings > Read cycle 125 ms, 250 ms, 500 ms, 1s,258,5s,10s, 15 s, 2s
20s,0r30s
Basic settings > Timeout 125 ms, 250 ms, 500 ms, 1s,2s,5s,10s,or1 min 2s
Basic settings > Retrials Off, 1, 2, 3,4, 5,10, or 20 1
<#8 Modbus master (COMMAND)>
Parameter Selectable Range or Selections Initial Value
Command settings > 1to 8 On/Off Off
Command settings > 1 to 8 > First-CH, Last-CH C01 to C30 Co1, Co1
Command settings > 1 to 8 > Address 1to 247 1
Command settings > 1 to 8 > Slave Registers Input registers: 30001 to 39999, 300001 to 365535 30001
Hold registers: 40001 to 49999, 400001 to 465535
Command settings > 1 to 8 > Type INT16, UINT16, INT32_B, INT32_L, UINT32_B, INT16
UINT32_L, FLOAT_B, or FLOAT_L
<#9 AUX>
Parameter Selectable Range or Selections Initial Value
Recovery Status for Comm. Buffer > DO/SW Continue, Clear Clear
Modbus master/Ext loop > Auto recovery On/Off Off
#10 Web, E-Mail
<#1 Web>
Parameter Selectable Range or Selections Initial Value
Web > Use/Not Use/Not Not
Web > Page type Operator or Monitor Operator
Web > On/Off On/Off Off
Web > Command On/Off Off
Web > Access control On/Off Off
Web > User name Up to 16 alphanumeric characters -
Web > Password Up to 6 alphanumeric characters -
<#2 Basic E-Mail Settings>
Parameter Selectable Range or Selections Initial Value
Basic E-Mail settings > SMTP server name Up to 64 alphanumeric characters -
Basic E-Mail settings > Port number 0 to 65535 25
Basic E-Mail settings > Recipient 1 Up to 150 alphanumeric characters -
Basic E-Mail settings > Recipient 2 Up to 150 alphanumeric characters -
Basic E-Mail settings > Sender E-mail address assigned by the network
administrator (up to 64 alphanumeric characters) -
<#3 Alarm E-Mail Settings>
Parameter Selectable Range or Selections Initial Value
Alarm E-Mail settings > Recipient1 On/Off Off
Alarm E-Mail settings > Recipient2 On/Off Off
Alarm E-Mail settings > Alarm1 to 4 On/Off Off
Alarm E-Mail settings > Include INST On/Off Off
Alarm E-Mail settings > Include source URL On/Off Off

Alarm E-Mail settings > Subject
Alarm E-Mail settings > Header1
Alarm E-Mail settings > Header2

Up to 32 alphanumeric characters
Up to 64 alphanumeric characters
Up to 64 alphanumeric characters

(CX) Alarm_summary

IM 04L31A01-04E

47



List of Parameters

<#4 Scheduled E-Mail Settings>

Parameter Selectable Range or Selections Initial Value
Scheduled E-Mail settings > Recipient1 On/Off Off
Scheduled E-Mail settings > Interval 1h,2h,3h,4h,6h,8h,12h,0or24 h 24 h
Scheduled E-Mail settings > Ref.time 00:00 to 23:59 00:00
Scheduled E-Mail settings > Recipient2 On/Off Off
Scheduled E-Mail settings > Interval 1h,2h,3h,4h,6h,8h,12h,0or24 h 24 h
Scheduled E-Mail settings > Ref.time 00:00 to 23:59 00:00
Scheduled E-Mail settings > Include INST On/Off Off
Scheduled E-Mail settings > Include source URL ~ On/Off Off

Scheduled E-Mail settings > Subject
Scheduled E-Mail settings > Header1
Scheduled E-Mail settings > Header2

Up to 32 alphanumeric characters
Up to 64 alphanumeric characters
Up to 64 alphanumeric characters

(CX) Periodic_data

<#5 System E-Mail Settings>

Parameter Selectable Range or Selections Initial Value
System E-Mail settings > Recipient1 On/Off Off
System E-Mail settings > Recipient2 On/Off Off
System E-Mail settings > Include source URL On/Off Off

System E-Mail settings > Subject
System E-Mail settings > Header1
System E-Mail settings > Header2

Up to 32 alphanumeric characters
Up to 64 alphanumeric characters
Up to 64 alphanumeric characters

(CX) System_warning

<#6 Report E-Mail Settings>

Parameter Selectable Range or Selections Initial Value
Report E-Mail settings > Recipient1 On/Off Off
Report E-Mail settings > Recipient2 On/Off Off
Report E-Mail settings > Include source URL On/Off Off

Report E-Mail settings > Subject
Report E-Mail settings > Header1
Report E-Mail settings > Header2

Up to 32 alphanumeric characters
Up to 64 alphanumeric characters
Up to 64 alphanumeric characters

(CX) Report_data

#11 Aux, Time zone

Parameter Selectable Range or Selections Initial Value
AUX > Tag/Channel Tag/Channel Tag

AUX > Memory alarm Off,1 h,2h,5h, 10 h, 20 h, 50 h, or 100 h 1h

AUX > Language English, Japanese, German, French, or Chinese English
AUX > Partial Use/Not Not

Time zone > Difference from GMT —1200 to 1200 0

Batch Use/Not Use
#12 Control

<#1 Control action>

Parameter Selectable Range or Selections Initial Value
Control action > PID number 1t08 8

Control action > Control period 250 ms, 500 ms, or 1 s~ 250 ms
Control action > Zone PID On/Off Off
Control action > Restart mode > Fixed-Point Continue, Manual, or Auto Continue
Control action > Restart mode > Program Continue, Manual, or Reset Continue
Control action > Initial PID Temp or Press+Flow Temp
Control action > Auto tuning On/Off Off
Control action > Loop number 1or2 1

Control action > Control mode Off, Single, Cascade, PVSwitching, or Retrans Single
Control action > Control mode > Method Range, PVHigh, or Signal Range
Control action > Program control On/Off Off
Control action > PID control mode Follow-up or Fixed-point Follow-up

"Fixed to 1 s for A/D integral time of 100 ms.
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<#2 Input setting>

Parameter Selectable Range or Selections Initial Value
Input setting > Loop humber 1or2 1
Input setting > Burnout > Measure1 Off, Up, or Down Up
Input setting > Burnout > Measure2 Off, Up, or Down Up
Input setting > Burnout > Remote Off, Up, or Down Up
Input setting > RJC > Measure1 External or Internal Internal
Input setting > RJC > Measure1 > Volt (uV) —20000 to 20000 uV ouv
Input setting > RJC > Measure2 External or Internal Internal
Input setting > RJC > Measure2 > Volt (uV) —20000 to 20000 uV ouv
Input setting > RJC > Remote External or Internal Internal
Input setting > RJC > Remote > Volt (uV) —20000 to 20000 uV ouv
<#3 DI/DO/SW Registration>
Parameter Selectable Range or Selections Initial Value
Contact input > Module CTRL1-DI, CTRL1-DO, INT-SW1, INT-SW2, INT-SW3 CTRL1-DI
Contact input > DI0O01 to 006 None, AllControlStop, None
Contact input > DO001 to 006 AllControlStart, ControlStart/Stop (1 or 2),
Contact input > SWO001 to 018 Remote/Local (1 or 2), Auto/Man (1 or 2),
Cascade (1-2), Auto1-2, Man1-2, SPNumber0 to 3 bit,
ProgramRun, ProgramReset, Hold, Advance,
PatternNoO to 4bit, PVSwitching1 to 4, MemoryStart/Stop,
PVSwitching1 or 2, MemoryStart/Stop, Trigger, AlarmAck,
TimeAdjust,MathStart/Stop, MathReset, ManualSample,
Panel1Load to Panel3Load, Message1 to 8, Snapshot
<#4 AUX (Alarm mode...)>
Parameter Selectable Range or Selections Initial Value
AUX > Loop number 1or2 1
AUX > Remote setting Off or Remote Off
AUX > Alarm mode ALWAYS, STOP, or STOP/MAN ALWAYS
AUX > SP No. selection source 1 or 2 On/Off 1: On, 2: Off
AUX > PV/SP math On/Off Off
AUX > CLOG error Error, Skip Error
AUX > Event output setting Common/Separate Common
<#5 Output processing>
Parameter Selectable Range or Selections Initial Value

Output processing > Loop number
Output processing > Control output

1or2

1

Relay, Voltage-pulse, Current-output, or On/Off-control Current-output

Output processing > Cycle time 1sto 1000 s 30s

Output processing > Analog-output type 4-20 mA, 0-20 mA, 20-4 mA, or 20-0 mA 4-20 mA

<#6 Relay>

Parameter Selectable Range or Selections Initial Value

Relay > FAIL On/Off Off

Relay > Self diagnosis On/Off Off

Relay > DO001 to 006 De_energize/Hold, De_energize/Nonhold, Energize/Nonhold
Energize/Hold, or Energize/Nonhold

<#7 Tuning setting>

Parameter Selectable Range or Selections Initial Value

Tuning setting > Loop number
Tuning setting > 01 to 21
Tuning setting > 01 to 21 > Item ID

Tuning setting > 01 to 21 > [tem name

1or2

On/Off

SP, A1, A2, A3, A4, P,

I, D, OH, OL, MR, PO, H, DR, BS1, FL1,
BS2, FL2, RT, RBS, RFL, or W01 to W12

Up to 6 alphanumeric characters

1
01-12: On, 13-21: Off

01: SP, 02: A1, 03: A2, 04: A3,
05: A4, 06: P, 07:1,08: D,
09: OH, 10: OL, 11: MR,

12: PO, 13 to 21: —

01-12: Same as Item ID
13-21: -
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<#8 External loop setting>

Parameter Value or Selections Initial Value
#1 Basic setting
Loop number Ext1 to Ext4 Ext1
Comm. Off/On On/Off Off
Modbus address 1to 247 1
Connecting model UT320, UT321, UT350, UT351, UT420, UT450, uUT320
UT520, UT550, UT750, or Others
Loop select First or Second First
Tag Up to 8 alphanumeric characters EXT-01
Tag comment Up to 8 alphanumeric characters -
Auto reading Execute Execute
PV > Decimals Oto4 0
PV > Unit Up to 6 alphanumeric characters -
SP > Decimals Oto4 0
SP > Unit Up to 6 alphanumeric characters -
OUT > Decimals Oto4 0
OUT > Unit Up to 6 alphanumeric characters %
Control span lower —30000 to 30000, span width: 30000 0
Control span upper —30000 to 30000, span width: 30000 10
Control mode SingleLoopControl, CascadePrimaryLoop, SingleLoopControl
CascadeSecondaryLoop, CascadeControl,
ControlBackup, PVSwitching, PVAutoSelector,
PVHoldFunction, DualLoopControl,
Temperature-Humidity,Cascade-2Uni,
PVSwitching-2Uni, PVAutoSelector-2Uni, or
CustomComputation
Control output Relay, Voltage-pulse, Current-output, or Relay
On/Off-control
Alarm Off, PH-H-E (PV high-limit alarm (energize)), Off

PV-L-E (PV low-limit alarm (energize)),

Dev-H-E (Deviation high-limit alarm (energize)),

Dev-L-E (Deviation low-limit alarm (energize)),

Dev-H-D (Deviation high-limit alarm (deenergize)),

Dev-L-D (Deviation low-limit alarm (deenergize)),

Dev-HL-E (Deviation high & low limit alarm (energize)),
D-W-HL-E (Deviation within high & low limits alarm (energize)),
PV-H-D (PV high-limit alarm (deenergize)),

PV-L-D (PV low-limit alarm (deenergize)),

PV-H-ES (PV high-limit alarm (energize/hold)),

PV-L-ES (PV low-limit alarm (energize/hold)),

Dev-H-ES (Deviation high-limit alarm (energize/hold)),
Dev-L-ES (Deviation low-limit alarm (energize/hold)),
Dev-H-DS (Deviation high-limit alarm (deenergize/hold)),
Dev-L-DS (Deviation low-limit alarm (deenergize/hold)),
Dev-HL-ES (Deviation high & low limit alarm (energize/hold)),
D-W-HL-ES (Deviation within high & low limits alarm (energize/hold)),
PV-H-DS (PV high-limit alarm (deenergize/hold)),

PV-L-DS (PV low-limit alarm (deenergize/hold)),

TimeUp1 (Timer, upward detection, hours & minutes),
TimeDown1 (Timer, downward detection, hours & minutes),
TimeUp2 (Timer, upward detection, minutes & seconds),
TimeDown2 (Timer, downward detection, minutes & seconds),
Sensor (Sensor grounding alarm),

Prog-Diag (Self diagnosis output),

FAIL (FAIL output),

SP-H (SP high-limit),

SP-L (SP low-limit),

Out-H (Output high-limit),

Out-L (Output low-limit),

Burnout1 (Heater burnout alarm 1), or

Burnout2 (Heater burnout alarm 2),

IM 04L31A01-04E



List of Parameters

Parameter Value or Selections Initial Value

#2 Parameter address setting

Loop number Ext1 to Ext4 Ext1

PV: Input 30001 to 39999, 300001 to 365535, 40003
40001 to 49999, or 400001 to 465535

SP : Setting 30001 to 39999, 300001 to 365535, 40004
40001 to 49999, or 400001 to 465535

OUT: Output 30001 to 39999, 300001 to 365535, 40005
40001 to 49999, or 400001 to 465535

Control mode 30001 to 39999, 300001 to 365535, 40008
40001 to 49999, or 400001 to 465535

Remote/Local 30001 to 39999, 300001 to 365535, 40008
40001 to 49999, or 400001 to 465535

Operation STOP/RUN 30001 to 39999, 300001 to 365535, 40205
40001 to 49999, or 400001 to 465535

Alarm status 30001 to 39999, 300001 to 365535, 40011
40001 to 49999, or 400001 to 465535

SP number 30001 to 39999, 300001 to 365535, 40010
40001 to 49999, or 400001 to 465535

PID number 30001 to 39999, 300001 to 365535, 40009
40001 to 49999, or 400001 to 465535

Auto reading 30001 to 39999, 300001 to 365535, 40008
40001 to 49999, or 400001 to 465535

#3 Tuning setting

Tuning setting > Loop number Ext1 to Ext4 Ext1

Tuning setting > 01 to 21 On/Off Off

Tuning setting > ltem ID SP, A1, A2, A3, A4, P, |, D, OH, OL, MR, H, DR, ETC
DB, PO, or ETC

Tuning setting > ltem name Up to 6 alphanumeric characters ETC

Tuning setting > Register address 30001 to 39999, 300001 to 365535, 40001
40001 to 49999, 400001 to 465535

Tuning setting > Decimal point Oto4 0

Tuning setting > Range lower —30000 to 30000, span width: 30000 0

Tuning setting > Range upper —30000 to 30000, span width: 30000 10

Setting mode (Control)

#1 Control input range

Parameter Selectable Range or Selections Initial Value

Input range > Loop number 1or2 1

Input range > Input type PV1, PV2, RemoteSP, or PVrange PVA

Input range > Mode TC, RTD, Scale, or 1-5V TC

Input range > Type DCV, TC, or RTD TC

Input range > Range TC: R/S/B/K/E/J/TIN//W/L/U/PLATI/PR/WRe K
RTD: PTAJPT
DCV: 20mV, 60mV, 200mV, 2V, 6V, 20V, or 50V

Input range > Span lower-limit Within the range of Range —200.0

Input range > Span upper-limit Within the range of Range 1370.0

Input range > PV range —30000 to 30000 Lower: 0.0,

Upper: 2000.0

Input range > PV switching Lower limit —30000 to 30000 0.0

Input range > PV switching Upper limit —30000 to 30000 2000.0

Input range > Scale —30000 to 30000 Lower: 0.00,

Input range > Unit

Input range > Square root
Input range > Low-cut
Input range > Bias

Input range > Filter

Input range > Ratio

Up to 6 alphanumeric characters

On/Off

0.0% to 5.0%

On/Off

Selectable range when On: EUS (-100.0% to
100.0%) of the measurement span

On/Off

1sto120s

On/Off

Selectable range when On: 0.001 to 9.999

Upper: 200.00
Off

1.0%

Off

0.0%

Off
1s
Off
1.000
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#2 Control alarm

Parameter Selectable Range or Selections Initial Value
Alarm > Loop number 1or2 1
Alarm >1to 4 On/Off Off
Alarm > Type PV-H (PV high-limit), PV-L (PV low-limit), PV-High

Dev-H (deviation high-limit), Dev-L (deviation low-limit),

Dev-H&L (deviation high & low limit),

D-W-H&L (deviation within high & low limits), SP-H (SP high-limit),

SP-L (SP low-limit), Out-H (Output high-limit), or Out-L (Output low-limit)
Alarm > Standby On/Off Off
Alarm > Relay output On/Off Off
Alarm > Number DO001 to DO006 or SW001 to SW018 DO001
Alarm > SP number 1t08 1
Alarm > Alarm value1 to 4 PV high/low limits: EU (0 to 100%) of measurement span, 1370.0

SP high/low limits: EU (0 to 100%) of measurement span,

Deviation high/low limits: EUS (—100 to 100%) of measurement span,
Deviation high & low limit and deviation within high & low limits: EUS (0 to 100%)
of measurement span, or Output high/low limit: —5.0 to 105.0%

#3 Operation-related parameter/zone PID

Parameter Selectable Range or Selections Initial Value
Operation related/zone PID > Loop number 1or2 1
Operation related/zone PID > Suppressing function Off or Overshoot Off
Operation related/zone PID > Ramp-rate time unit Hour, Minute, or Second Hour
Operation related/zone PID > SP ramp-down-rate  On/Off Off
Selectable range when On: 1digit to EUS (100.0%) 1570.0
of the measurement span
Operation related/zone PID > SP ramp-up-rate On/Off Off
Selectable range when On: 1digit to EUS (100.0%)  1570.0
of the measurement span
Operation related/zone PID > Tag Up to 8 alphanumeric characters INT-01
Operation related/zone PID > Tag comment Up to 8 alphanumeric characters -
Operation related/zone PID > Reference point EU (0.0 to 100.0%) of the measurement span 1370.0
Operation related/zone PID > Switching hysteresis EU (0.0 to 100.0%) of the measurement span 7.8
Operation related/zone PID > Reference deviation On/Off Off
Selectable range when On: 1digit to EUS (100.0%) 7.8
of the measurement span
#4 PID parameters
Parameter Selectable Range or Selections Initial Value
PID parameters > Loop number 1or2 1
PID parameters > PID Number 1t08 1
PID parameters > Target setpoint EU (0% to 100%) of the measurement span —200.0
PID parameters > Proportional band(P) 0.1% t0 999.9% 5.0%
PID parameters > Integral time(l) 0 s to 6000 s 240s
PID parameters > Derivative time(D) 0 s to 6000 s 60 s
PID parameters > Output lower limit —5.0% to 105.0% 0.0%
PID parameters > Output upper limit —5.0% to 105.0% 100.0%
PID parameters > Shutdown On/Off Off
PID parameters > Manual reset —5.0% to 105.0% 50.0%
PID parameters > Relay hysteresis > Value EUS (0.0 to 100.0%) of the measurement span 7.8
PID parameters > Relay hysteresis > Position Mid, High, or Low Mid
PID parameters > Reverse/Direct Reverse or Direct Reverse
PID parameters > Preset output —5.0% to 105.0% 0.0%
#5 Control group setting
Parameter Selectable Range or Selections Initial Value
Control group > Group number 1to 4 1
Control group > Group name Up to 16 alphanumeric characters CONTROL GROUP1
Control group > 1 to 4 On/Off 1/2: On, 3/4: Off
Control group > 1 to 4 > Kind Int-Loop, Ext-Loop, or Meas-CH Int-Loop
Control group > 1 to 4 > Number Int-Loop: 01 or 02 1: 01, 2: 02

Ext-Loop: 01 to 04
Meas-CH: 01 to 06

52

IM 04L31A01-04E



List of Parameters

#6 Ten-segment linearizer I/0

Parameter Selectable Range or Selections Initial Value
Ten-segment linearizer 1/0 > Loop number 1or2 1
Ten-segment linearizer 1/0 > Input type PV1 or PV2 PVA
Ten-segment linearizer 1/0 > Mode Off, Biasing, or Approximation Off
Ten-segment linearizer 1/0 > Input 1 to 11 Linearizer bias: EU (-5.0% to 105.0%) of 1:-200.0, 2: 1370.0,
the measurement span 3to 11: -200.0
Linearizer approximation: EU (—5.0% to 105.0%) of
the measurement span
Ten-segment linearizer 1/0 > Output 1 to 11 Linearizer bias: EUS (—100.0% to 100.0%) of 0.0
the measurement span
Linearizer approximation: EU (—5.0% to 105.0%) of
the measurement span
#7 Program control related (only when program control is ON)
<#1 Program parameter setting>
Parameter Selectable Range or Selections Initial Value
#1 Pattern initial setting
Program initial setting > Pattern number 1to 4 (/PG1), 1 to 30 (/PG2) 1
Program initial setting > Segments 0to 99 0
Program initial setting > Segment setting method  Time, Ramp Time
Program initial setting > Pattern name Up to 16 alphanumeric characters Pattern 1
Program initial setting > Action loop > Loop 1, 2 On/Off Off
#2 Wait action setting
Wait action setting > Wait zone 110 5 > Loop 1, 2 On/Off Off
>H, L EUS (100.0%) of the measurement span 1 digit
Wait action setting > Wait time 00:00:00 to 99:59:59 00:00:00
#3 Pattern start setting
Pattern start setting > Start target setpoint EU (0% to 100%) of the measurement span —200.0
>Loop 1, 2
Pattern start setting > Start code StartTargetSP, RampPV1 to RampPV6, TimePV, StartTargetSP
#4 Program pattern setting
Program pattern setting > Segment number 1 to specified number of segments 1
Program pattern setting > Ramp/Soak select Ramp, Soak Ramp
Program pattern setting > Target setpoint > Loop 1, 2 EU (0% to 100%) of the measurement span —200.0
Program pattern setting > Segment time' 00:00:00 to 99:59:59 00:00:01
Program pattern setting > Ramp-rate time unit? Hour, Minute Hour
Program pattern setting > Ramp? 1 digit to EUS (100.0%) of the measurement span 1 digit
Program pattern setting > Segment PID group No. 1 to specified PID number 1
Program pattern setting > Segment shift action Continue, HoldShift, LocalShift, ResetShift Continue
Program pattern setting > Wait action Off, Shift, Within Off
Program pattern setting > Wait zone number 1to5 1
#5 Event setting
Event setting > Segment number 1 to specified number of segments 1
Event setting > Event kind PVEvent, TimeEvent TimeEvent
Event setting > Event No. 1-8, 9-16 1-8
Event setting > TimeEvent 1 to 16 On1, On2, On3, Off Off
Event setting > TimeEvent 1 to 16 > On-time, Off-time  00:00:00 to 99:59:59 00:00:00
Event setting > PVEvent 1 to 16> Loop Off, 1t0 6 Off
Event setting > PVEvent 1 to 16 > Loop > Type PV-High, PV-Low, Deviation-High, Deviation-Low, PV-High
Deviation-H&L, Dev-within-H6L, SP-High, SP-Low,
Output-High, Output-Low
Event setting > PVEvent 1 to 16 > Loop > Value PV: EU (0% to 100%) of the measurement span 1370.0
Deviation: EUS (0% to 100%) of the measurement span 1570.0
SP: EU (0% to 100%) of the measurement span 1370.0
Output: -5.0 % to 105.0 % 105.0 %
#6 Hysteresis (PV event)
Hysteresis (PV event) > PV event > 0.0% to 10.0 0.5%

Hysteresis 1 to 16
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Parameter Selectable Range or Selections Initial Value
#7 Repeat action setting

Repeat action setting > Repeat action Off, On, Repeat Off

Repeat action setting > On > Repeat frequency 1to 999 1

Repeat action setting > Repeat action 1 to specified number of segments 1

> Repeat start segment

Repeat action setting > Repeat action 1 to specified number of segments 1

> Repeat end segment

"When [Time] is specified for the segment setting method.

2When [Ramp] is specified for the segment setting method.

<#2 Event output setting*>

Parameter Selectable Range or Selections Initial Value
Event output > Pattern number 1to 4 (/PG1), 110 30 (/PG2) 1

Event output > Event kind PVEvent, TimeEvent TimeEvent
Event output > Relay Output EV1 to 16 On, Off Off

Event output > On EV1 to 16 > Number DO001 to DO006, SW001 to SW018 DO001
Program pattern end signal > Relay Output On, Off Off

Program pattern end signal > On > Number DO001 to DO006, SW001 to SW018 DOO001

* With version 3.01, event output setting is included as item #6 within #1 Program pattern setting.

<#3 AUX (Auto message, Display position)>

Parameter Selectable Range or Selections Initial Value
AUX (Auto message, Display position) > On, Off On

Auto message for program Run/Reset On/Off

AUX (Auto message, Display position) > 1or2 Loop 1,2:1,2
Program display position > Position > Loop 1 to 6

AUX (Auto message, Display positin) > On, Off Off

Auto change to program run display

<#4 AUX (Event group)>

Parameter Selectable Range or Selections Initial Value
AUX (Event group) > Pattern number 1to 4 (/PG1) or 1 to 30 (/PG2) 1

AUX (Event group) >1to 5 On, Off On

AUX (Event group) > On 1 to 5 > Kind PVEvent, TimeEvent Time Event
AUX (Event group) > Number 01 to 05 110 5:011t0 05

#8 Detailed settings (#7 when the program control function is OFF)

<#1 Control function>

Parameter Selectable Range or Selections Initial Value
Control function > Loop number 1or2 1
Control function > SP Tracking Off/On On
Control function > PV tracking On/Off Off
Control function > Target setpoint limiter > Lower EU (0.0% to 100.0%) of the measurement span —200.0
Control function > Target setpoint limiter > Upper  EU (0.0% to 100.0%) of the measurement span 1370.0
Control function > Output velocity limiter On/Off Off

Enter the value for On: 0.1%/s to 100.0%/s 100.0%/s
Control function > Anti-reset windup Auto or Manual Auto

Enter the value for Manual: 50.0% to 200.0% 100.0%
<#2 Hysteresis (Alarm)>
Parameter Selectable Range or Selections Initial Value
Hysteresis (Alarm) > Alarm > Loop number 1or2 1
Hysteresis (Alarm) > Alarm > Hysteresis1 to 4 EUS (0.0% to 10.0%) of the measurement span 7.8
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<#3 DIO monitor and operation setting>

Parameter Selectable Range or Selections Initial Value
DIO monitor and operation setting > 01to 12 01

DIO entry number

DIO monitor and operation setting > On/Off On, Off Off

DIO monitor and operation setting > Kind

DI-1, DO-1, DO-2, DIO-11, DIO12, DO-2P, DIO-12P  DI-1

DIO monitor and operation setting > SW number  SW001 to SW018 SWo001
DIO monitor and operation setting > DO number > DOO001 to DO006 DOO001
ON
DIO monitor and operation setting > DO number > DOO001 to DO00S, DOO001
OFF
DIO monitor and operation setting > DI number DI001 to DIO06 DI001
DIO monitor and operation setting > Tag Up to 8 alphanumeric characters -
DIO monitor and operation setting > Tag comment Up to 8 alphanumeric characters -
DIO monitor and operation setting > Up to 8 alphanumeric characters -
Operation property >ON > Label
DIO monitor and operation setting > Red, green, blue, blue violet, brown, orange, Red
Operation property >ON > Color yellow-green, light blue, violet, gray, lime, cyan,

dark blue, yellow, light gray, or purple
DIO monitor and operation setting > Up to 8 alphanumeric characters -
Operation property >OFF > Label
DIO monitor and operation setting > Red, green, blue, blue violet, brown, orange, Red
Operation property >OFF > Color yellow-green, light blue, violet, gray, lime, cyan,

dark blue, yellow, light gray, or purple
<#4 DI/DO label setting>
Parameter Selectable Range or Selections Initial Value
DI/DO label setting > Module CTRL1-DI, CTRL1-DO CTRL1-DI

DI/DO label setting > DI001 to DIO06 > Label
DI/DO label setting > DO001 to DO006 > Label

Up to 16 alphanumeric characters
Up to 16 alphanumeric characters

DI001 to DI006
DO001 to DO006

#9 Detailed settings (#8 when the program control function is OFF)

<#1 PV/SP math, Retransmission>

Parameter

Selectable Range or Selections

Initial Value

PV/SP math, Retransmissin > Loop number
PV/SP math, Retransmissin > PV/SP

PV/SP math, Retransmissin > Mode
PV/SP math, Retransmissin >

Calculation expression

PV/SP math, Retransmissin > PV range >
Lower-limit

PV/SP math, Retransmissin > PV range >
Upper-limit

PV/SP math, Retransmissin > Unit

PV/SP math, Retransmissin > PV swithing > Lower
PV/SP math, Retransmissin > PV swithing > Upper
PV/SP math, Retransmissin > Math error

1or2

PV, PV1, PV2, SP

(Depending on the control mode)
On/Off

Up to 120 alphanumeric characters

-30000 to 30000 (upper-lower < 30000)

-30000 to 30000 (upper-lower < 30000)

Up to 6 alphanumeric characters
-30000 to 30000 (upper-lower < 30000)
-30000 to 30000 (upper-lower < 30000)
Over, Under

1
Value depending on the
control mode

Off

Previously determined
control input channel No.
Measurement range

of calcuration expression
initial viue

Measurement range

of calcuration expression
initial viue

Lower limit of PV range
Upper limit of PV range
Over

<#2 Logic math>

Parameter Selectable Range or Selections Initial Value
Logic math > Setting number 1-6, 7-12 1-6

Logic math > Relay Off, DO001 to DO006, SW001 to SW018 Off

Logic math > Calculation expression Up to 120 alphanumeric characters -

<#3 Constant>

Parameter Selectable Range or Selections Initial Value

Constant > W01 to W12

—9.9999E+29 to —1.0000E-30, O,
1.0000E-30 to 9.9999E+29

1
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Set mode

#1 Range, Alarm

Parameter Selectable Range or Selections Initial Value
First-CH 01 to 06 01

Last-CH 01 to 06 01

Range > Mode Volt, TC, RTD, Scale, Delta, DI, Sqrt, or Skip Volt

Range > Range

20 mV, 60 mV,200mV,2V,6V,20V,50V, R, S,B,K, 2V
E,J, T,N, W, L, U, PLATI, PR, Wre, PT, JPT, Level, or Cont

Range > Span Lower - —2.000
Range > Span Upper - 2.000
Alarm >1to 4 On/Off Off
Alarm > Type H: High limit, L: Low limit, R: Rate-of-change, H
T: Delay high, t: Delay low
Alarm > Value - 0.000
Alarm > Relay On/Off Off
Alarm > Relay Number 101 to 106, DO001 to DO006, or SW001 to SE018 101
Alarm > Detect On/Off On
#2 Tag, Moving average, Alarm delay time
Parameter Selectable Range or Selections Initial Value
First-CH 01 to 06, 101 to 106, or 201 to 212 01
Last-CH 01 to 06, 101 to 106, or 201 to 212 01
Tag Up to 16 alphanumeric characters 01
Moving average > Count 0ff, 2,3,4,5,6,7,8,9,10, 11,12, 13, 14, 15, or 16  Off
Alarm delay > Time 15103600 s 10s
#3 Trend/Save interval, User key
Parameter Selectable Range or Selections Initial Value
Trend/Save interval > Time/div 1 min, 2 min, 5 min, 10 min, 20 min, 30 min, 1 h,2h,4h,or10h 1 min
Trend/Save interval > Auto save interval 10 minutes to 31 days 1h
USER key > Action None, Trigger, AlarmACK, MathStart/Stop, MathReset, AlarmACK
ManualSample, Message1 - Message8, or Snapshot
#4 Message
Parameter Selectable Range or Selections Initial Value
Message > Characters No. 1 to No. 8 Up to 16 alphanumeric characters -
#5 Display
<#1 Group set, Trip line>
Parameter Selectable Range or Selections Initial Value
Group number 1t06 1
Group set > Group name Up to 16 alphanumeric characters GROUP 1
Group set > CH set 01 to 06, 101 to 106, or 201 to 212 01-06
Group set>Tripline>No. 1toNo.4  On/Off Off
Group set > Trip line > Position 0% to 100% 100%

Group set > Trip line > Color

Red, green, blue, blue violet, brown, orange, yellow-green, light blue,
violet, gray, lime, cyan, dark blue, yellow, light gray, or purple

No.1: Red, No.2: Green,
No.3: Blue, No.4: Yellow

<#2 Color>
Parameter Selectable Range or Selections Initial Value
Color > CH1 Red, green, blue, blue violet, brown, orange, yellow-green, Red
light blue, violet, gray, lime, cyan, dark blue, yellow,
light gray, or purple
Color > CH2 Same as above Green
Color > CH3 Same as above Blue
Color > CH4 Same as above Blue-violet
Color > CH5 Same as above Brown
Color > CH6 Same as above Orange
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<#3 Zone, Graph, Partial>

Parameter Selectable Range or Selections Initial Value
First-CH 01 to 06 01
Last-CH 01 to 06 01
Zone > Lower 0% to 95% 0%
Zone > Upper 5% to 100% 100%
Graph > Division 4,5,6,7,8,9,10, 11,12, 0r C10 10
Graph > Bar graph Normal or Center Normal
Graph > Scale position Offor 1to 6 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span 0.000

value — 1 digit or minimum scale value + 1 digit

to maximum scale value — 1 digit (for channels

set to scale or square root computation)
<#4 View, Direction, LCD>
Parameter Selectable Range or Selections Initial Value
View > Direction > Trend Horizontal, Vertical, or Horizon2 Vertical
View > Direction > Bar graph Horizontal or Vertical Vertical
View > Background > Measure White or Black White
View > Background > Control White or Black Black
View > Trend line 1, 2, or 3 dots 2 dots
View > Trip line 1, 2, or 3 dots 2 dots
View > Grid Auto, 4 div, 5 div, 6 div, 7 div, 8 div, 9 div, 10 div, 10 div

11 div, or 12 div
View > Scroll 5s,10s,205s,30s, 1 min 5s
View > Scale digit Normal or Fine Normal
LCD > Brightness 1t08 4
LCD > Backlight saver > On/Off On/Off Off
LCD > Backlight saver > Saver time 1 min, 2 min, 5 min, 10 min, 30 min, or 1 h 1h
LCD > Restore Key or Key+Alm Key+Alm
<#5 Control (Color)>
Parameter Selectable Range or Selections Initial Value
Select Internal or External Internal
CH101 Red, green, blue, blue violet, brown, orange, Red

yellow-green, light blue, violet, gray,

lime, cyan, dark blue, yellow, light gray, or purple
CH102 Same as above Green
CH103 Same as above Blue
CH104 Same as above Blue-violet
CH105 Same as above Brown
CH106 Same as above Orange
<#6 Control (Zone, Graph, Partial>
Parameter Selectable Range or Selections Initial Value
First-CH 101 to 106 or 201 to 212 101
Last-CH 101 to 106 or 201 to 212 101
Zone Lower 0% to 95% 0%
Zone Upper 5% to 100% 100%
Graph > Division 4,5,6,7,8,9,10, 11,12, 0r C10 10
Graph > Bar graph Normal or Center Normal
Graph > Scale position Off or 1to 10 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span 0.1

value — 1 digit or minimum scale value + 1 digit
to maximum scale value — 1 digit (for channels
set to scale or square root computation)

IM 04L31A01-04E

57



List of Parameters

<#7 Math (Color)>

Parameter Selectable Range or Selections Initial Value

CH31 Red, green, blue, blue violet, brown, orange, Red
yellow-green, light blue, violet, gray,
lime, cyan, dark blue, yellow, light gray, or purple

CH32 Same as above Green
CH33 Same as above Blue
CH34 Same as above Blue-violet
CH35 Same as above Brown
CH36 Same as above Orange
CH37 Same as above Yellow-green
CH38 Same as above Light blue
CH39 Same as above Violet
CH40 Same as above Gray
CH41 Same as above Lime
CH42 Same as above Cyan

<#8 Math (Zone, Graph, Partial>

Parameter Selectable Range or Selections Initial Value
First-CH 31to 42 31
Last-CH 31to 42 31
Zone > Lower 0% to 95% 0%
Zone > Upper 5% to 100% 100%
Graph > Division 4,5,6,7,8,9,10, 11,12, 0r C10 10
Graph > Bar graph Normal or Center Normal
Graph > Scale position 1 to 10 or Off 1
Partial On/Off Off
Expand 1% to 99% 50%
Boundary Minimum span value + 1 digit to maximum span 0.00

value — 1 digit or minimum scale value + 1 digit
to maximum scale value — 1 digit (for channels
set to scale or square root computation)

#6 File, DST

Parameter Selectable Range or Selections Initial Value
File > Header Up to 32 alphanumeric characters -

File > Directory name Up to 8 alphanumeric characters DATAO

File > Save data Unsave or All All

Daylight saving time (YY/MM/DD HH) > Summer Off/On Off

Daylight saving time (YY/MM/DD HH) > Winter Off/On Off

#7 Save/Load, Clear data

Parameter Selectable Range or Selections Initial Value

#1 Save settings - _
#2 Load settings - -
#3 Save data - _
#4 Load display data - -
#5 Load event data - -
#6 File list - _
#7 Delete - -
#8 Format - _
#9 Clear data - _

#8 Time

Parameter Selectable Range or Selections Initial Value

Time set - -
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#9 Math set1 (expression, alarm)

Parameter Selectable Range or Selections Initial Value
First-CH 31to 42 31
Last-CH 31to 42 31
Math range > Math On/Off On/Off Off
Math range > Calculation expression 40 characters or less. 01
Math range > Span Lower —9999999 to 99999999 (decimal point: within 4 —200.00
digits to the right of the decimal point)
Math range > Span Upper —9999999 to 99999999 (decimal point: within 4 200.00
digits to the right of the decimal point)
Math range > Unit Up to 6 alphanumeric characters -
Alarm > 1to 4 On/Off Off
Alarm > Type H L T ort H
Alarm > Value Value within the measurement span 0.00
Alarm > Relay On/Off On/Off Off
Alarm > Relay Number 101 to 106 or DO001 to DO006 101
#10 Math set2 (constant)
Parameter Selectable Range or Selections Initial Value
Constant > K01 to K12 —9.9999E+29 to —1.0000E-30, O, 1
1.0000E-30 to 9.9999E+29
#11 Math set3 (tag, TLOG, rolling average, alarm delay)
Parameter Selectable Range or Selections Initial Value
First-CH 31to 42 31
Last-CH 31to 42 31
Tag > Tag Up to 16 alphanumeric characters 31
TLOG > Timer No. 1,2,0r3 1
TLOG > Sum scale Off, /s, /min, or /h Off
Rolling average On/Off Off
Rolling average > Interval 1s,2s5,3s,4s,5s,6s, 105, 12s, 15s, 20s, 30s, 10s
1 min, 2 min, 3 min, 4 min, 5 min, 6 min, 10 min,
12 min, 15 min, 20 min, 30 min, or 1 h
Rolling average > Number of samples 1to 64 1
Alarm delay time 1st0 3600 s 10s
#12 Batch set
Parameter Selectable Range or Selections Initial Value
Application name Up to 16 alphanumeric characters -
Supervisor name Up to 16 alphanumeric characters -
Manager name Up to 16 alphanumeric characters -
Batch number Up to 16 alphanumeric characters -
Lot number Up to 4 alphanumeric characters
Auto increment On/Off On
Disp information Batch, Time Batch
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